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ICONICS LICENSE AGREEMENT 
 

YOU SHOULD CAREFULLY READ THE FOLLOWING  
TERMS AND CONDITIONS! 

 
Opening and using the enclosed software for any purpose indicates your 
acceptance of the terms and conditions of this license agreement.  If you do not 
agree with them you should return all software, documentation and copy 
protection keys within seven days of shipment unopened and your money will be 
refunded. 
 
ICONICS provides this program and licenses its use in the United States, Puerto 
Rico, or internationally.  You assume the responsibility for the selection of the 
program to achieve your intended results, and for the installation, use and results 
obtained from this program. 
 

LICENSE 
You are granted a personal license to use this program under the terms stated in 
this Agreement.  You may: 1) Install and use the program on a single machine; and 
2) make a single archival back-up copy of the program for the sole purpose of 
supporting your use of the single program on a single machine.   You may not 
copy, translate, modify or adapt the program, or any portion thereof, or 
incorporate it, in whole or any part, in any other product, create derivative works 
based on the program, or any portion thereof, or license others to reproduce any 
copies of the program, or any portion thereof, and you may not decompile, 
disassemble or reverse engineer the program, or any component thereof except as 
permitted by law, and then only after having prior requested in writing from 
ICONICS any interoperability information you are attempting to obtain. 
 

TERM 
The license is effective until terminated.  It will terminate if you fail to comply with 
any term or condition of this Agreement.  You agree, upon such termination, to 
destroy the program and all copies that were made from it and to promptly return 
any copy protection key(s) to ICONICS. 
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LIMITED WARRANTY 
ICONICS WARRANTS THE CD-ROM, DVD OR PHYSICAL DISKETTES, ON WHICH 
THE PROGRAM IS FURNISHED, AND PHYSICAL DOCUMENTATION TO BE FREE OF 
DEFECTS IN MATERIALS AND WORKMANSHIP UNDER NORMAL USE FOR A 
PERIOD OF NINETY (90) DAYS FROM THE DATE OF DELIVERY TO YOU AS 
EVIDENCED BY YOUR RECEIPT.  THIS PROGRAM IS PROVIDED “AS IS” WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE IMPLIED WARRANTIES OF TITLE, NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK 
AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  
SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF 
ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. 
 
ICONICS SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED WARRANTIES OF TITLE, 
NON-INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.  IN PARTICULAR, WITH RESPECT TO ANY PARTICULAR APPLICATION, 
USE OR PURPOSE, IN NO EVENT SHALL ICONICS INC. BE LIABLE FOR ANY OTHER 
COMMERCIAL DAMAGE, INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, 
CONSEQUENTIAL OR OTHER DAMAGES.  ICONICS DOES NOT WARRANT THAT 
THE FUNCTIONS CONTAINED IN THE PROGRAM WILL MEET YOUR 
REQUIREMENTS OR THAT THE OPERATION OF THE PROGRAM WILL BE 
UNINTERRUPTED OR ERROR FREE. 
 

LIMITATION OF REMEDIES 
ICONICS’ entire liability and your exclusive remedy shall be the replacement of any CD-
ROM, DVD or diskette not meeting ICONICS’ “Limited Warranty” which is returned to 
ICONICS with a copy of your receipt within the warranty period.  The remedy for breach 
of this warranty shall be limited to replacement and shall not encompass any other 
damages including but not limited to loss of profit, special, incidental, consequential, or 
other similar claims arising out of the use or inability to use such program even if 
ICONICS has been advised of the possibility of such damages, or for any claim by any 
other third party. 
 

GENERAL 
This Agreement will be governed by the laws of the Commonwealth of Massachusetts.  
Should you have any questions concerning this Agreement, you may contact ICONICS in 
writing at: 
 

ICONICS, Inc. 
100 Foxborough Boulevard 

Foxborough, MA 02035 
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You acknowledge that you have read this Agreement, understand it and agree to be 
bound by its terms and conditions.  You further agree that it is the complete and exclusive 
statement of the Agreement between you and ICONICS which supersedes any proposal 
or prior Agreement, oral or written, and any other communications between you and 
ICONICS relating to the subject matter of the Agreement. 
 

ICONICS RETURN POLICY 
All sales are final (NO RETURNS) unless one of the following conditions is applicable:  
Program is returned in its original packaging material within 7 days after shipment.  In 
such a case, a full refund is provided, less all incurred shipping and handling costs.  
Program is returned within 30 days from the original shipment date.  In such a case a 20% 
restocking fee is applicable.  No returns are allowed on OPC ToolWorX or ActiveX 
ToolWorX.  All returns must have an appropriate RMA number. 
 

EXPORT COMPLIANCE 
You agree to comply with the United States of America’s current Export Administration 
Regulations (EAR) and agree that you will not distribute or supply this product in violation 
of the EAR.  You are responsible for securing any export approval or license as may be 
needed under the EAR.  Additionally, you are responsible for obtaining local customs 
clearance as applicable and paying all duties, taxes and other charges. 
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1 SYSTEM REQUIREMENTS 
 
Before installing any products, please make sure you have 
the correct prerequisites installed.  

 
ICONICS Suite 
ICONICS advanced visualization, productivity, and 
sustainability solutions are built on its flagship products: 
GENESIS64™ HMI/SCADA, Hyper Historian™ plant historian, 
AnalytiX® solution suite and MobileHMI™ mobile apps. 
ICONICS is leading the way in cloud-based solutions with 
IoTWorX™, which helps customers embrace the Internet of 
Things (IoT) and Industry 4.0. This end-to-end software 
solution provides remote cloud monitoring and analytics via 
low-cost IoT gateway devices. Delivering information 
anytime, anywhere, ICONICS solutions scale from the 
smallest standalone embedded projects to the largest 
enterprise applications.  
 
ICONICS System Requirements vary between: 

• Minimum Requirements 
• Medium-powered Requirements 
• High-powered Requirements 
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System Requirements - Minimum Requirements 
 

CPU 
Dual Core 64-bit processors (e.g., AMD Athlon 64 X2, Intel 
Xeon, and AMD Phenom) 
 
Memory 
4 GB of RAM is required (6 GB Recommended)   
Note: It is recommended that the system page file size be a 
minimum of four (4) times the size of installed (physical) 
RAM. 
Note: It is recommended that the virtual memory allotment 
be two times the amount of physical memory (RAM) on the 
system. 
 
Hard Disk 
At least 4 GB free hard disk space is required (10 GB 
Recommended) 
 
Video Card 
Onboard Video Memory (256MB) 
Display resolution minimum - 1024x768, 32-bit color 
DirectX 9 or 10 Video Card or better 
 
Operating System 

• Windows 10 x64 (Pro or Enterprise Edition)  
• Windows 10 x64 Enterprise 2016 LTSB 
• Windows 10 x64 Enterprise 2019 LTSC 
• Windows 8.1 x64 (Pro or Enterprise Edition) 
• Windows Server 2019  
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• Windows Server 2016 x64  
• Windows Server 2012 R2 x64  
• Windows Server 2012 x64   

Note: Windows 10 1809 (October 2018 update) is required 
for MobileHMI UWP app. 
Note: Server-class operating system highly recommended 
for web hosting and AnalytiX features. 
 
.NET Framework 
Microsoft .NET Framework 4.7.2 
 
Web Server/Access 
Microsoft Internet Information Services (IIS) 7.0 or higher  
 
Edge, Firefox, Safari, Chrome, or Internet Explorer 11 
Note: Internet Explorer only supported for WPF WebHMI, 
not HTML5 WebHMI 
 
SQL Server 

• Microsoft SQL Server 2019 
• Microsoft SQL Server 2017  
• Microsoft SQL Server 2016  
• Microsoft SQL Server 2014  

 
Notes:  

• The connection to SQL Server data source may be 
either local or remote. 

• ICONICS supports SQL databases with encryption. 
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System Requirements - Medium-powered Requirements 
CPU 
Quad Core 64-bit processors or better (e.g., AMD Athlon 64 
X2, Intel Xeon, and AMD Phenom) 
 
Memory 
8 GB of RAM or higher   
Note: It is recommended that the system page file size be 
a minimum of four (4) times the size of installed (physical) 
RAM.  
Note: It is recommended that the virtual memory allotment 
be two times the amount of physical memory (RAM) on the 
system. 
 
Hard Disk 
At least 4 GB free hard disk space is required (10 GB 
Recommended) 
 
Video Card 
Onboard Video Memory (500MB) 
Display resolution minimum - 1024x768, 32-bit color 
DirectX 9 or 10 Video Card or better 
 
Operating System 

• Windows 10 x64 (Pro or Enterprise Edition)  
• Windows 10 x64 Enterprise 2016 LTSB 
• Windows 10 x64 Enterprise 2019 LTSC 
• Windows 8.1 x64 (Pro or Enterprise Edition) 
• Windows Server 2019  
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• Windows Server 2016 x64  
• Windows Server 2012 R2 x64  
• Windows Server 2012 x64   

Note: Windows 10 1809 (October 2018 update) is required 
for MobileHMI UWP app. 
Note: Server class operating system highly recommended for 
web hosting and AnalytiX features. 
 
.NET Framework 
Microsoft .NET Framework 4.7.2 
 
Web Server/Access 
Microsoft Internet Information Services (IIS) 7.0 or higher  
 
Edge, Firefox, Safari, Chrome, or Internet Explorer 11 
Note: Internet Explorer only supported for WPF WebHMI, 
not HTML5 WebHMI 
 
SQL Server 

• Microsoft SQL Server 2019 
• Microsoft SQL Server 2017  
• Microsoft SQL Server 2016  
• Microsoft SQL Server 2014  

 
Notes:  

• The connection to SQL Server data source may be 
either local or remote. 

• ICONICS supports SQL databases with encryption. 
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System Requirements - High Powered Requirements 
 
CPU 
Quad Core 64-bit processors or better (e.g., AMD Athlon 64 
X2, Intel Xeon, and AMD Phenom) 
 
Memory 
16 GB of RAM or higher   
Note: It is recommended that the system page file size be 
a minimum of four (4) times the size of installed (physical) 
RAM.  
Note: It is recommended that the virtual memory allotment 
be two times the amount of physical memory (RAM) 
on the system. 
 
Hard Disk 
At least 4 GB free hard disk space is required (10 GB 
Recommended) 
 
Video Card 
Onboard Video Memory (1GB) 
Display resolution minimum - 1920x1080, 32-bit color  
DirectX 9 or 10 Video Card or better 
 
Operating System 

• Windows 10 x64 (Pro or Enterprise Edition)  
• Windows 10 x64 Enterprise 2016 LTSB 
• Windows 10 x64 Enterprise 2019 LTSC 
• Windows 8.1 x64 (Pro or Enterprise Edition) 
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• Windows Server 2019  
• Windows Server 2016 x64  
• Windows Server 2012 R2 x64  
• Windows Server 2012 x64   

Note: Windows 10 1809 (October 2018 update) is required 
for MobileHMI UWP app. 
Note: Server-class operating system highly recommended 
for web hosting and AnalytiX features. 
 
.NET Framework 
Microsoft .NET Framework 4.7.2 
 
Web Server/Access 
Microsoft Internet Information Services (IIS) 7.0 or higher  
 
Edge, Firefox, Safari, Chrome, or Internet Explorer 11 
Note: Internet Explorer only supported for WPF WebHMI, 
not HTML5 WebHMI 
 
SQL Server 

• Microsoft SQL Server 2019 
• Microsoft SQL Server 2017  
• Microsoft SQL Server 2016  
• Microsoft SQL Server 2014 

 
Notes:  

• The connection to SQL Server data source may be 
either local or remote. 

• ICONICS supports SQL databases with encryption. 
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NOTE: The requirements described above are based on 
typical applications. Depending on your specific application, 
the minimum requirements may vary.  
 
Optional Hardware 

• Ethernet adapter, WiFi card, or cellular 3G/4G 
• USB port (for hardware license) 
• Serial COM ports or other adapters (for data I/O) 

 
Uninstalling 
It is recommended by ICONICS to use Add/Remove 
Applications from Control Panel to uninstall the applications. 
Since applications are registered in the registry, Add/Remove 
uninstalls the product and makes the required registry 
changes for you. 
 
If you uninstall some common components that are used by 
the product, you may be required to register those 
components again or simply reinstall the product. 
 
NOTE: Do not delete the files and directories manually; 
doing so will leave the registry entries intact and interfere 
with future installations. Please use the uninstall feature of 
the operating system!
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2 INSTALLING ICONICS PRODUCT SUITE 
The following steps detail the ICONICS Product Suite system 
installation. 
The ICONICS Product Suite installation uses a standard 
InstallShield installer to provide you with options for 
installing components, adding new or existing users, 
configuring the database engine that you use and the size of 
the tables that are created, and more. 
Warning: Prior to installation, verify that the system meets 
minimum hardware and software requirements, as described 
in the System Requirements section. Installation will abort if 
the minimum requirements are not met. 
Note: You cannot install any 10.8x and later product from 
Remote Desktop when using a shared drive. In such 
instances, it is suggested that you copy the installation's 
sources to a local drive or share the drive via Windows 
networking rather than via Remote Desktop. 
Important Note: Uninstall previous versions of the 
ICONICS Product Suite before installing the latest version 
of ICONICS Product Suite.  

2.1 Starting the Installation Process 
Note: Installations of Internet Information Services differ 
depending on the operating system, but can be found in the 
Server Manager under Roles in Windows Server 2012 or later 
and should be turned on. 
To Install GENESIS64: 

1. Insert the installation DVD into your optical drive. 
The installer opens if auto start is operating 
correctly. If not, open the DVD drive window and 
double-click the Default.hta file icon. Select 
“ICONICS Suite Installation”. The User Account 
Contorol Dialog appears and Select “Yes”. 
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2. Choose ‘Install’. This installs everything needed for 
running GENESIS64. If you don’t have SQL Server 
2017 installed locally, you are prompted to install 
it. (You can choose No if you plan on using an 
older version of SQL Server, or you are going to 
use remote SQL Server). 
The ICONICS Suite – InstallShield Wizard 
window appears. 

3. Click on the Install Button 

 
A message appears that reads, ‘ICONICS 
GENESIS64 installation requires a reboot.’  

4. Click the Yes Button. 
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After restart, the ‘User Account Control’ window appears.   
5. Click the Yes Button to continue the installation. 

 
NOTE: Steps 3,4 and 5 may need to be repeated 
multiple times depending on the number of 
dependencies being installed.  
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6. In the Welcome Dialog, click the Next button to 
view the License Agreement step. 

 
7. Read the License Agreement.  
8. If you agree to the terms and conditions, click the 

“I accept the terms of the license agreement” 
radio button.  

9. Click the Next button to continue. 
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10. In the Setup Type Dialog, select the type of setup 
you wish to perform: Typical or Custom. 

 
• Typical installation installs allows for 

selection of the product suites you want to 
install and is the default selection for 
installation. (See following screenshots). 

 
• Custom installation allows you to specify 

install location on the computer as well as 
individual components within a product suite. 

 
Since the Setup procedure varies slightly depending on 
the installation type you choose, the installation of each 
is described fully in the two sections that follow. Refer 
to “Typical Installation” on the next page or “Custom 
Installation” later within this section. 
 

2.2 Typical Installation 
Typical installation is intended to install all of the GENESIS64 
applications and tools. It creates all of the supporting 
databases as necessary.  
You need to provide the correct database connection and 
logon information. Once those steps are completed, the 
installation does not require as much of your attention.  
If you are installing GENESIS64 on a system that has a 
previous version of ICONICS products already installed, 
uninstall the older version before installing GENESIS64. If you 
have uninstalled a previous version, Setup leaves the 
database files intact on your system for you to use at a future 
date. Typical installation asks you if you want to overwrite or 
leave the supporting database files.  
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To Perform a Typical Installation: 
1. For a typical installation select the Suite selection as 

shown below. Setup evaluates your system for 
compliance with the requirements, and then posts a 
confirmation dialog box. 

  
2. Insert Facility AnalytiX Serial Number 

 
NOTE: This does not apply if Facility AnalytiX is not selected on the suite 
selection page. If this was left at default, you may uncheck the installation 
now. 
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3. Select the Email Agent you are going to use, depending 
on your organization.   

  
NOTE: This does not apply if AlarmWorX is not selected on the suite 
selection page. If this was left at default, you may uncheck the installation 
now. 

4. Select the pager agent that you would like to install, 
depending on your organization 

 
NOTE: This does not apply if AlarmWorX is not selected on the suite 
selection page. If this was left at default, you may uncheck the installation 
now 
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5. The Logon Information screen appears. Enter the 
requested user name/password info. Then click Next. 
Note: From the Logon Information Dialog, you can 
choose to use either a local machine account or a 
domain security account, as well as create a new user or 
use an existing user account. 

 
6. Clicking Next brings up the Administrative User Setup. 

This is used to set a default security username and 
password for the ICONICS Installation. You can 
optionally bypass the security by selecting the 
demonstration System.  
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7. Clicking Next brings up the Database Server 
Dialog.  Here you can select local or remote database 
together with database settings and the authentication 
that server database is secured under.  

8. Click Next. At this time, additional components are 
installed automatically. 

  
 

• Use Active Databases – Databases from previous 
installation of Genesis64 will be attached to this 
installation 

• Silent Configuration –  Databases will be installed 
with selected setting and there won’t be additional 
dialog with advanced database setting 

• Include all Samples – Install sample data that you 
can experiment with 

• Overwrite all Databases – Overwrite older 
Databases 

• Upgrade all Configurations – Automatically 
update all configurations to their most recent 
version 

• Use Unified Database –  Install all configuration in 
one unified database 
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When the ICONICS GENESIS64 – InstallShield Wizard 
window pops up, click on the Install Button 

 
9. The System Setup Dialog will now appear. You can 

adjust the Project and Unified Databases as needed.  
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10. You can either leave the Include all samples checkbox 
enabled (in order to install sample data that you can 
experiment with) or disable this checkbox to install 
blank tables.  
 
Advanced configuration will allow settings for additional 
sizing options on the database and log files. You can 
enable Unified database (one database that contains all 
the configurations) and also you can enable Overwrite 
all (overwrite all existing databases), or you can use 
Upgrade automatically all database configurations 
(existing databases will be automatically upgraded to 
the newest version). 

  
11. Click the Install button to continue the installation. 
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12. After completing the installation, the Wizard Completed 
dialog box appears. Click the Finish button. 

 
Note: It is recommended that you restart your system, 
although not required. 
If the installation seems to hang, check to see that there are 
not any alert boxes posted that require dismissal prior to 
completing the installation. 
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2.3 Custom Installation 
Custom installation varies slightly from the Typical/Complete 
installation in that you select the components you wish to 
install.  
1. Select the Custom Selection installation Setup Type.  

 
2. You will then be prompted to select the Destination 

Location. Specify the destination by selecting Browse, or 
select Next if the default location is correct. 

 



System Requirements ICONICS Product Suite Getting Started 

 ICONICS 2-14 

3. Click the checkboxes to install your selected 
components then click Next. 

 
4. Enter the Facility AnalytiX Serial Number if you 

selected this option. Then click Next 
NOTE: This step may not be required if Facility AnalytiX 
was not selected 

5. Select Options for email Agent. Then click Next. NOTE: 
This step doesn’t apply when you do not install 
AlarmWorX 

6. Select Options for Pager Agent. Then click Next. 
NOTE: This step doesn’t apply when you do not install 
AlarmWorX 

7. Click Next and specify the user account to be used by 
this application. 
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8. Click the Next button to continue the installation. 
9. Clicking Next brings up the Administrative User Setup. 

This is used to set a default security username and 
password for the ICONICS Installation. You can 
optionally bypass the security by selecting the 
demonstration System. 
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10. In the Database Server Dialog you can select local or 
remote database together with database settings and 
authentication that is the database server secured 
under. 
 

• Use Active Databases – Databases from previous 
installation of Genesis64 will be attached to this 
installation 

• Silent Configuration –  Databases will be installed 
with selected setting and there won’t be additional 
dialog with advanced database setting 

• Include all Samples – Install sample data that you can 
experiment with 

• Overwrite all Databases – Overwrite older Databases 
• Upgrade all Configurations – Automatically update 

all configurations to their most recent version 
• Use Unified Database –  Install all configuration in 

one unified database 
 

11. The Database and Services Setup Dialog will now 
appear. You can either leave the Include all samples 
checkbox enabled (in order to install sample data that 
you can experiment with) or disable this checkbox to 
install blank tables. Advanced configuration will allow 
settings for additional sizing options on the database 
and log files. You can enable Unified database (one 
database that contains all the configurations) and also 
you can enable Overwrite all (overwrite all existing 
databases). 

12. When the ICONICS GENESIS64 – InstallShield Wizard 
window pops up, click on the Install Button 
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13. The System Setup Dialog will now appear. You can 

adjust the Project and Unified Databases as needed.  
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14. You can either leave the Include all samples checkbox 
enabled (in order to install sample data that you can 
experiment with) or disable this checkbox to install 
blank tables.  
 
Advanced configuration will allow settings for 
additional sizing options on the database and log files. 
You can enable Unified database (one database that 
contains all the configurations) and also you can 
enable Overwrite all (overwrite all existing databases), 
or you can use Upgrade automatically all database 
configurations (existing databases will be 
automatically upgraded to the newest version). 
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15. After completing the installation, the Wizard Completed 
dialog box appears. Click the Finish button. 

 

2.4 Uninstalling ICONICS Product Suite 
The ICONICS Product Suite software can be uninstalled 
(removed) from the system. It is recommended that you back 
up all of your project-related files before uninstalling. If your 
operating system requires a login, you must log in with 
administrator capability to uninstall. Uninstalling ICONICS 
Product Suite Software (or its components) will not uninstall 
the Licensing software. Your valid license will remain 
activated on your PC.  

It is recommended by ICONICS to use Add/Remove 
Applications from Control Panel to uninstall the applications. 
Since applications are registered in the Registry, 
Add/Remove uninstalls the product and makes the required 
Registry changes for you. If you uninstall some common 
components that are used by the product, you may be 
required to register those components again or simply 
reinstall the product. 
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To uninstall GENESIS64: From the Windows Start menu, 
select Settings > Control Panel. Double-click Programs 
and Features. From the list of programs that you can 
remove, select ICONICS GENESIS64. Click Change/Remove 
or Uninstall to remove GENESIS64 and all of its 
components. Select Remove, and then click the Next 
button. When the files are removed, the uninstall program 
will indicate that the process is complete. 
 
If the Control Panel is not found under Settings, right click 
on Start button and select Control Panel. In the Control 
Panel window, under Programs choose ‘Uninstall a 
program” option. Right-click on GENESIS64 and all of its 
components and choose uninstall option  

 
When the files are removed, “Uninstall Complete” message 
will pop up. Click on Finish button. 
 
NOTE: If GenDemo From ICONICS is installed it can be 
removed as well using the same process.  
Note: Do not delete the files and directories manually; doing 
so will leave the Registry entries intact and interfere with 
future installations. Please use the uninstall feature of the 
operating system!  
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3 ICONICS SOFTWARE LICENSING 
3.1 Software and Hardware Keys 

ICONICS Product Suite licensing is handled by a software key 
license registration system that does not require a hardware 
protection key. However, ICONICS does offer an optional 
hardware key which you can purchase.  

3.1.1 Software Licensing 
The software key is a licensing key that resides on the hard 
drive of a computer. Each software key is used on a single, 
specific computer and is used only once. It is activated using 
a Site Key (license file) that is tied to the computer that is 
being licensed.  
An activated license is required to use the software in full 
production mode. This license designates which products 
may be used, as well as the I/O point-count limit that 
controls the number of active data points (tags) that can be 
used by a system. 
For important details about registering and activating 
software licenses for your ICONICS Product Suite 
installations, refer to the ICONICS .NET Licensing 
Readme.htm file, which is available on your AnalytiX 
installation DVD (and as a link from the disc’s Info Center). 

3.1.2 Hardware Key 
The optional hardware key is a USB thumb drive (or flash 
drive) that you can move from system to system. AnalytiX 
recognizes the hardware key on the system you have the key 
attached to. A hardware key is easier and is a more reliable 
way of moving a license from one machine to another than a 
software key. 
Upon insertion of the USB key into an available USB port, the 
necessary drivers are automatically loaded.  
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A green status light will illuminate upon successful 
connection. Should the USB key be missing or unplugged 
during operation of ICONICS Product Suite software, plug 
the USB key back in either within an hour of removal or upon 
system reboot; otherwise the hardware-based license will not 
be immediately recognized. 
Should you require a replacement key, visit 
http://www.iconics.com/supportworx. New users must create 
an account through the ICONICS Web Licensing Utility in 
order to request replacement keys. 

3.2 License Utility 
The Software License Utility provides full authorization for 
use to any purchased ICONICS Product Suite product and its 
available options.  

3.2.1 Running the License Utility 
To launch the License Utility from the Windows Start menu, 
select Programs > ICONICS .NET Licensing > License 
Utility. 

 



ICONICS Product Suite Getting Started Licensing 

ICONICS 3-3 

3.2.2 License File 
 

Once you have opened the Software License Utility, you can 
browse for the Site Key (License File) itself. Either click on the 
Browse… button in the License File section of the window 
OR click on File in the top menu, then Select License File…. 
 

 
 

This brings up the Windows Explorer so that you may browse 
for the License File itself. Once you have located the file, 
double-click it or click Open to proceed. 
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3.2.3 Activating the 30-day Trial/Emergency License 
 
Within the License Utility (Software License Activation 
for .NET) dialog box, you can click on the Activate Trial 
License box to initiate a 30-day trial/emergency license.  
NOTE: This license can be activated only once per 
machine. 

 
You will then see a warning about proceeding with activating 
the 30-day trial/emergency license. Click Yes, should you 
wish to proceed. 
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You will then see an additional warning confirming that you 
understand that enabling the trial license will invalidate any 
other software license that is currently active on the machine. 
Click Yes should you wish to proceed. 

 
Once the 30-day trial/emergency license has been enabled, 
you will see the following messages: 

 

 
 

The PC will then be authorized to run for a one-time only, 
30-day backup period. The PC can be fully authorized at any 
time during or at the conclusion of this temporary backup 
period. Clicking No in the initial windows returns you to the 
License Utility (Software License Activation for .NET) dialog 
box and preserves the existing license. 
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Note: Temporary backup license authorization is intended 
for urgent backup situations only. Clicking OK invalidates the 
existing license and activates a temporary backup 
authorization, permanently overwriting any existing license. 
Thus, please use caution when activating a temporary 
backup license authorization. 

3.2.4 Killing a Software Key License 
Killing a software key license deletes it and removes the 
current software license from the machine. 
To Kill or Delete the Existing Software License:  
1. Select Kill Current License within the License Utility 

(Software License Activation for .NET) dialog box. Using 
this option, you can remove the current software license 
from the current machine. 

 
 



ICONICS Product Suite Getting Started Licensing 

ICONICS 3-7 

A warning message appears on the screen as shown in the 
figure below.  

 
 

IMPORTANT: If you kill your license, you need to get a new 
license from ICONICS to restart your ICONICS Product Suite 
product. 
 
2. Click Yes to continue, or click No to exit. Clicking Yes 

displays one of the following warning messages.  
If you are killing a trial or emergency license, once you 
click Yes you are done.  
Note:  A trial or emergency license cannot be credited 
back to the web-based License Generator using the Kill 
Code.   
If you are killing a permanent, registered license, after 
you click Yes, the following warning message appears. 
Notice that the message lists the old Site Key, and a Kill 
Code. It also lists a .TXT file that has been written to the 
PC's desktop; the file name begins with "KillCode". This 
file contains the old Site Key and Kill Code that are 
listed in the message.  
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3. Click Yes to copy the Kill Code to the Windows 
Clipboard so that you can paste it elsewhere, such 
as in an email to ICONICS Support or on the 
ICONICS Web Licensing Utility. If you don't need 
to copy the Kill Code at this time, click No.  

4. Look on the desktop for the KillCode*.TXT file. 
Keep this file, and copy it to a safe location! 
You will have to use the information it contains to 
confirm that you have killed your license (via 
either the ICONICS Order Entry Department or 
the ICONICS Web Licensing Utility). 

5. Proceed with the online steps described in 4.4.3.1 
“Killing a License via the ICONICS Web Licensing 
Utility” 

Note: To reinstate a permanent license that you killed, 
you will need to provide the KillCode*.TXT file to 
ICONICS.  

Note:  If you uninstall the Software License Utility, the 
KillCode*.TXT file will be deleted. For this reason, make 
sure you copy the KillCode*.TXT file to a safe location 
or be sure to note or print its content before 
uninstalling the Software License Utility on the PC.   [* 
= Site Key that was killed.] 

3.3 License Viewer 
When you purchase licenses, the licenses are measured in a 
point count that determines the number of OPC tags that 
you can use in your application. One point count is used for 
most AnalytiX applications. There are two different modes 
for using tags in point counts: 
• On-demand mode. A system for dynamically using licensed 

points, and then reusing the points as needed. The count 
at any instance includes only active points in use.  
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• Configure mode. A system in which all points are 
statically configured in a static central location, inside 
the Unified Data Manager. All configured points are 
counted against the point count.  

The two mode types are not interchangeable and require 
you to buy a new license to upgrade your existing license 
status. 
At any time, you can use the License Viewer to review the 
license status of ICONICS products installed on that 
computer. You can access the License Viewer by: 
• From the Windows desktop: click Start > All Programs 

> ICONICS Licensing > ICONICS .NET Licensing > 
MonitorWorX Viewer. 

• From the Workbench: from the Tools ribbon click the 
Licensing button. Or from the File menu, select Tools, 
and then Licensing. The License Viewer displays as 
shown in the following image. 

 
The tab that displays initially is the Overview tab, where you 
can see general information about the license for the server 
that the node points to. You can view license information for 
GENESIS64, AnalytiX, Data Connectors, BizViz products 
(under the AnalytiX tab), and AlarmWorX Multimedia 
product features by using the tabs for those products.  
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To locate the nodes where individual product features are 
consuming the server's license counts, use the Diagnostics 
tab. 

3.4 Web Licensing 
You can use the ICONICS Web Licensing Utility to generate a 
new license, kill a license and transfer a license. One function 
of the ICONICS Web Licensing Utility is to use it to upgrade 
your license. 
 
Supported operating systems for using the ICONICS Web 
Licensing Utility to upgrade your license include Windows 8 
x64 (Professional or Enterprise Edition), Windows 7 x64 
(Professional, Ultimate, or Enterprise Edition), Windows 
Server 2008 R2 x64, Windows Vista x64 SP2 (Business, 
Ultimate, or Enterprise Edition), Windows Server 2008 
 
 x64 or Windows Server 2003 x64. Using the utility will 
require Internet access and a web browser (e.g. Internet 
Explorer 6.0 and up). 

3.4.1 Acquiring a New Software License 
Users of ICONICS software can use the ICONICS Web 
Licensing Utility to acquire a new software key license.  

3.4.1.1 Issuing a New Software License 
 

1. On the machine where you want the ICONICS 
Product Suite license to reside, open the License 
Utility by going to Start -> Programs -> ICONICS 
Licensing -> ICONICS .NET Licensing -> License 
Utility. This should open the Software License 
Activation for .NET window. 

 



ICONICS Product Suite Getting Started Licensing 

ICONICS 3-11 

2. You will see a dialog come up with a Site Code and 
“No Current Site Key” within the Site Key text box. 
Leave this window open. 

 
3. Go to http://www.iconics.com/supportworx and 

launch the Web Licensing Utility Site by clicking on 
the “License Now” link on the bottom left of the 
page.  

 

 
 

http://www.iconics.com/supportworx
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Or, from ICONICS website 
(http://www.iconics.com), select “License a 
Product” from the bottom-right Customer 
Connection area. 
 

4. The main page of the Web Licensing Utility will 
load. Click on the “Software” button to access the 
Software License Options. 

 
5. You will be required to log in to access the 

Software License Options. Enter your email address 
and password and click on the “LOGIN” button. If 
you do not yet have an account, you can create 
one by clicking on the “Create New Account” link 
near the bottom of the page. 

 
 

http://www.iconics.com/
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6. Once you have logged into the website, click on 
the “New License” link in the top navigation bar. 

 
7. Enter your Product Registration Numbers and 

Customer Keys for the products to license, then 
click “Next”. 

 
NOTE: Your Product Registration Number and 
Customer Key are usually inside the DVD package 
that ICONICS sent to you. 
 

 
8. In the next screen, you will be requested to 

identify the end user for whom the license is being 
issued. You can look up a list of users that have 
been previously entered by clicking on the 
“Existing End Users” link or can enter a new one by 
clicking on the “Create New” link. 

 

 
 

9. Clicking the Existing End Users link will open a new 
window with a list of previously entered end users 
(either entered by you or tied to the product 
registration numbers entered in the previous 
screen). Select an end user from the list and click 
“Select” or double-click the selected end user.  
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If you, yourself, are the end user and you are not 
listed in the grid, you can click on the “I am the 
End User” link to enter your data as the new end 
user. After identifying the end user, click on “Next”. 
 

 
 

10. In the next screen, you will see a list of the 
products that are available for you to license. 
Check all the products that you would like to 
license. Copy the Site Code from the license utility 
of the destination machine and paste it into the 
Site Code box of the current web page, then click 
on “Next”. 
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11. Review the license information before proceeding. 
Click on “Generate Key” to issue the new Site Key. 

 

 
 

12. The next page will show you a summary of what 
will be your license, as well as your Site Key and 
License File. 

 

 
 

13. Download the license file (*.glic) by clicking on the 
link. You will need this file to license the machine. 
NOTE: If you misplace the file after receiving it, 
you can use the View License link with your 
Product Registration Number to download it 
again. 

14. In the Software License Activation Utility, click on 
the “Browse” button and look for the license file 
that you downloaded from ICONICS website. 



Licensing ICONICS Product Suite Getting Started 

 ICONICS 3-16 

15. Once you have selected the file and the License 
File textbox shows the file path, click on the 
“Activate License” button. 

16. You should then receive a popup message 
indicating the status of the license activation. You 
can click on “OK” to close the dialog. 

17. The Software License Activation Utility should now 
show the current license information, similar to the 
following image. 

 

 
 

18. Notice that the Site Code may change, as 
expected, but the Site Key should be the same one 
you saw on the website. 



ICONICS Product Suite Getting Started Licensing 

ICONICS 3-17 

3.4.2 Adding to an Existing Software License 
 

1. Go to http://www.iconics.com/supportworx and 
launch the Web Licensing Utility Site by clicking on 
the “License Now” link on the bottom left side of 
the page.  

2. Once you have logged into the website and 
accessed the Software License main page, click on 
the “Add to License” link in the top navigation bar. 

3. Enter your Existing Site Key, Product Registration 
Numbers and Customer Keys, then click “Next”. 

 
4. In the next screen, you will see a summary of the 

current license and a list of products that are 
available for you to add to the existing license. 
Check all the products that you would like to 
license. Copy the Site Code from the License Utility 
of the destination machine and paste it into the 
Site Code text box of the current web page, then 
click “Next”. 

 

http://www.iconics.com/supportworx


Licensing ICONICS Product Suite Getting Started 

 ICONICS 3-18 

5. Review the license information before proceeding. 
Select “Generate Key” as shown in the following 
image. 

 
 

6. The next screen will display the new Site Key and 
the link to your license file. Follow steps 13 to 18 
from 4.4.1.1 “Issuing a New Software License” to 
complete the licensing process. 

3.4.3 Upgrading a Software License Key 
There are four basic steps when it comes to upgrading a 
license via the Web Licensing Utility: 
 

• Step 1: Kill the older version license and credit it on 
our website 

• Step 2: Upgrade the license on our website 
• Step 3: Uninstall the older version of software and 

install the newer version 
• Step 4: License the newer version 

 
The order in which you do Step 2 and Step 3 does not 
matter.  
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3.4.3.1 Killing a License via the ICONICS Web Licensing Utility 
See Section 4.2.4 “Killing a Software Key License” for the 
initial steps on how to kill a license within the License Utility 
(Software License Activation for .NET) provided on the 
ICONICS Product Suite DVD. Be sure to take note of the Site 
Key and Kill Confirmation Code. This information is necessary 
to put the license back on the ICONICS website. NOTE: This 
information is also in the KillCode*.TXT file. 
[* = Site Key that was killed.] 
 
Once you have the Kill Code, follow these additional steps: 
 

1. Go to http://www.iconics.com/supportworx and 
launch the Web Licensing Utility Site by clicking on 
the “License Now” link on the bottom left of the 
page. 

 
2. The main page of the Web Licensing Utility will 

load. Click on the “Software” button to access the 
Software License Options. 

 

http://www.iconics.com/supportworx
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3. You will be required to log in to access the 
Software License Options. Enter your email address 
and password and click on the “LOGIN” button. If 
you do not yet have an account, you can create 
one by clicking on the “Create New Account” link 
near the bottom of the page. 

 

 
4. Click on the “Kill License” link in the top navigation 

bar. 
 



ICONICS Product Suite Getting Started Licensing 

ICONICS 3-21 

5. Copy the Site Key from the KillCode*.TXT file into 
the Site Key field on the web page, then copy the 
Kill Confirmation Code into the Kill Code field on 
the web page. Next, click on the “Remove Key” 
button on the web page. 

 

 
6. You will get a message confirming that the Site 

Key has been successfully deleted as shown in the 
image below. The products associated with the 
deleted Site Key will now be available to be re-
licensed. 
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3.4.3.2 Upgrading the License on ICONICS Website 
See Section 4.2.4 “Killing a Software Key License” for the 
initial steps on how to kill a license within the License 
Utility (Software License Activation for .NET) provided on 
the AnalytiX DVD. Be sure to take note of the Site Key and 
Kill Confirmation Code. This information is necessary to 
put the license back on the ICONICS website. NOTE: This 
information is also in the KillCode*.TXT file. 
[* = Site Key that was killed.] 

 
1. After you have copied your Site Key and Kill 

Confirmation Code in the previous step (either 
physically or electronically), you can now visit 
http://www.iconics.com/supportworx.  

 

 
2. Next, click on the “License Now” link. This opens a 

new Web page, as shown below. 
 

 

http://www.iconics.com/supportworx
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3. Click on the “Software” button to proceed. You will 
then be required to enter your email address and 
password for the site, as shown below. If you do 
not already have a login for this page, click on the 
“Create New Account” link near the bottom of the 
page. 

 

 
 

4. Once you have logged in, click on the “Kill License” 
link in the top navigation bar. 

5. Next, fill in your Site Key and Kill Code information 
that you copied while killing your previous license 
(see 4.2.4 “Killing a Software Key License”). 
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6. Once you kill the license on ICONICS’ website, you 
will receive an email containing the following 
information: 
• Site Key 
• Kill Code 
• Product for which you have killed the license 
The web page itself should now look similar to the 
figure below. 
 

 
 

7. At this point, you have completed killing the 
license. Notice that in the final “Kill License” page, 
as shown above, it states that if the license is 
eligible, it can be upgraded to the latest version 
and it provides a link for availability. 

3.4.3.3 Checking License Upgrade Availability 
The easiest way to check if your license is available for an 
upgrade is by clicking the link on the page immediately after 
you kill the license. Clicking the link brings you to the 
Upgrade License page. You can also get to this page by 
clicking on the “Upgrade License” link in the tree control 
(third item). 
 
Follow these steps to upgrade your license. 
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1. On the Upgrade License page, fill in your Product 
Registration Number and Customer Key. This is the 
same information you received in the web page 
and in your email after you have killed the license 
on our website. 

2. Click on “Next” when you have filled in the 
necessary information. 

3. If the license is available for an upgrade, you will 
see the available license on the page. 

 

 
4. Notice that the Product Description here shows a 

different product with an earlier version license 
(Version 8). Yours should reflect the license you 
have for your product. Check the available product 
that you would like to upgrade and click on “Next”. 

5. The next page is a confirmation page. Check that 
the information shown is correct and click on the 
“Upgrade” button to proceed. 

6. On the new page that loads next, you can see a list 
of upgraded products. Notice that the Product 
Description shows a license for a later version 
product (Version 9.2) instead of the earlier one 
(Version 8). 
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7. You should also receive an email with the license 
upgrade information. 

3.4.4 Upgrading a Hardware Key License 
Upgrading a hardware key license is similar to upgrading the 
software key license. You would follow the exact same 
procedure as upgrading a software license. In the case of a 
Hardware key License though, you will need the USB dongle 
in order to kill the license from it and put the new one onto 
the key. 
 

3.4.5 Licensing the New Version 
Now that you have upgraded the license, you can follow the 
regular procedure to license your machine with the new 
version. When it asks you for the Product Registration 
Number and the Customer Key, you can provide the same 
one. This information was sent to you in the last step of 
upgrading your license via email. If you need more 
information on how to license the machine with the 
upgraded license, please consult our application notes titled 
Licensing – Using the ICONICS Web License Utility for 
Software Key Licenses and Licensing – Using the ICONICS Web 
License Utility for Hardware Key Licenses, as it pertains to 
your individual situation. These Application Notes and more 
can be found via the Info Center on the AnalytiX DVD. 
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3.5 Cloud Licensing  
3.5.1 How Cloud Licensing Works 

ICONICS Cloud Licensing is a means of licensing ICONICS 
products that is specifically designed for applications 
running on public cloud, private cloud, or virtualized 
environments. Rather than maintaining the license locally on 
the machine, licenses are hosted by ICONICS on a publicly-
accessible data center.  
 
During normal operations of the licensed machine, the first 
action it takes when starting up is to request the license 
information according to its License Pool ID. This request 
requires the machine to have access to the internet in order 
to request the information from the ICONICS cloud licensing 
server.  
 
Once the license information has been successfully retrieved, 
the machine continues to operate using the licensing 
information retrieved from the web. The machine then 
periodically checks with the ICONICS Cloud Licensing server 
in order to validate the license. If it cannot validate the 
license for an extended period of time, the machine license 
will fail.  

3.5.2 Issuing a New Cloud License  
Follow these instructions to activate a license on a machine 
that currently has no license on it, or has a license on it that 
you want to overwrite. 
 
If your machine already has a license on it and you are 
looking to add another license to it, see the next section 
entitled, “Adding to an Existing Cloud License”. 
1. Go to http://www.iconics.com/support and click the 

“License Now” link. 

http://www.iconics.com/support
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2. In the new page that appears, select “Cloud” and log in 

with your username and password.  

 
Note: If you do not have a username and password pair, you 
can register for one using the “Create New Account” link at 
the bottom of the window. If you have a username and 
password but have forgotten them, you can click on the 
“Forgot Password” link at the bottom of the window. 
 
3. Once you have logged into the website, click on the 

“New License” link at the top. 
4. Enter your Product Registration Number(s) and 

Customer Key(s) for the products. 
 
Note: Your Product Registration Number(s) and Customer 
Key(s) are usually inside the DVD tin package that ICONICS 
sent when the product was purchased. 
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5. Click the “Next” button once you have entered all of 
your Product Registration Number(s). 

6. Choose an existing end user or enter new end user 
information. Click “Next” when done. 

 
Note: The existing end user dialog may take a few moments 
to appear. Please be patient. 
7. On the next screen, you see a list of the products that 

are available for you to license. Check all the products 
that you would like to license on this machine. Click 
“Next”. 

8. This page shows you a summary of what is in your 
license. Check to make sure everything is correct, then 
click on the “Generate Key” button. A page similar to 
the image below appears. 
 

 

3.5.3 Activating the License 
1. Open the “Platform Services Configuration” application 

by going to Start > Programs > ICONICS > Tools > 
Platform Services Configuration. 

2. Select the “License” tab. 
3. Select the radio button for “Cloud License” and enter 

the “License Pool” code that was provided by the Web 
License Utility. You can leave the “Password” blank. 
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4. Restart the FrameWorX64 Service. 

3.5.4 Adding to an Existing Cloud License 
1. Go to http://www.iconics.com/support and click the 

“License Now” link. 
2. In the new page that appears, select Cloud and log in 

with your user name and password. 
3. Once you have logged into the website, click on the 

“Add to License” link at the top. 
Note: It is very important to pick “Add to License” and not 
“New License”. Picking “New License” overwrites any existing 
license already activated on this machine. Make sure to pick 
“Add to License” if you are adding products to a machine 
that already has a license on it. 
 
4. Enter your existing License Pool ID and the Product 

Registration Number(s), and Customer Key(s) for the 
new products. 

 
Note: Your Product Registration Number(s) and Customer 
Key(s) are usually inside the DVD tin package that ICONICS 
sent when the product was purchased. 
 
5. Click the “Next” button once you have entered all of 

your Product Registration Number(s). 
6. Choose an existing end user or enter new end user 

information.  
Click “Next” when done. 

 
Note: The existing end user dialog may take a few moments 
to appear. Please be patient. 
 
 

http://www.iconics.com/support
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7. In the next screen, you see a list of the products that are 
available for you to license. Check all the products that 
you would like to license on this machine.  
Click “Next”. 

8. This page shows you a summary of what is in your 
license. Check to make sure everything is correct, then 
click on the “Generate Key” button. 

3.5.5 Killing a Cloud License  
1. Go to http://www.iconics.com/support and click the 

“License Now” link on the bottom left of the page. 
Select the “License” tab. 

2. In the new page that comes up, select “Cloud” and log 
in with your username and password.  

3. Once you have logged into the website, click on the 
“Kill License” link at the top. A page similar to the figure 
below appears. 
 

 
4. Enter your License Pool ID into the prompt.  

Click “Remove Pool”. 
5. A message confirming that the license has been 

successfully removed appears. You will also receive an 
email with the killed license information. The products 
associated with this License Pool are now safely parked 
on the website and available to be re-licensed at any 
time. 

http://www.iconics.com/support
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3.6 Demo Mode 
Without a valid license installed in your PC, it is still possible 
to use ICONICS Product Suite in Runtime mode. The 
software will check for a valid hardware or software license 
key on initialization. If none is found, ICONICS Product Suite 
runs in Demo Mode, which limits you to: 
• Twelve hours of runtime 
• Only 64 OPC tag connections (points) can be updated 
Running ICONICS Product Suite longer than the 12-hour 
limit generates a message stating that the demo time has 
been exceeded. You must then exit ICONICS Product Suite 
and reboot the PC. On restarting ICONISC Product Suite, you 
will get another 12-hour block of time in which to run.  If 
there are more than 64 tags on a particular screen, gray keys 
(or whatever is configured as the Point Failure character) will 
appear in place of the actual I/O data.
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4 GENESIS64  
4.1 Introduction 

Welcome to ICONICS GENESIS64™, a powerful, 64-bit, Web-
enabled, OPC HMI/SCADA suite. GENESIS64 takes full 
advantage of the convergence of 64-bit-based computing 
machinery, the release of new Microsoft operating systems 
and the growing customer demand for engaging three-
dimensional graphic visualization of business processes. 
 
GENESIS64 includes several solutions that allow for 
connectivity from the plant floor to corporate business 
systems to provide a 360-degree view of an entire 
organization. It was designed from the ground up to utilize 
new Microsoft technologies including: 

• Microsoft.NET 
• Windows Presentation Foundation (WPF) 
• 3D Hardware-accelerated Visualization 
• Windows Communication Foundation (WCF) 
• OPC Unified Architecture (OPC UA) 
• Windows User Access Control (UAC) Persistence 
• Windows Search and Organize 
• Windows Multitouch 
• Microsoft Bing™ Maps 

 
ICONICS GENESIS64 suite is comprised of the following products: 

• GraphWorX™64 
• AlarmWorX™64 
• TrendWorX™64 
• EarthWorX™ 
• AssetWorX™ 
• GridWorX™ 
• FDDWorX™ 
• ScheduleWorX™64 
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• Workbench™ 
• WebHMI 
• ReportWorX64 
• ReportWorX Express 
• ReportWorX 365 
• RecipeWorX 
• AlertWorX 
• KPIWorX 
• System Health 
• Data Explorer 

This Getting Started manual explains how you can: 
• Install the GENESIS64 software. 
• Familiarize yourself with and start using the 

Workbench multi-functional, centralized Web-
based environment 

• Access online help and technical support. 
Note: This manual is an abbreviated version of the full 
GENESIS64 Help documentation, which is available in the 
GENESIS64 Product help. 

4.2 What Is GENESIS64? 
GENESIS64 is a suite of tools that you can use to create state 
display and control software for equipment, machinery, or 
devices that use the OPC open process control standards of 
the OPC Foundation. OPC standards exist for both real-time 
data, alarms, and events, as well as for historical data that 
can be logged and replayed at a later date.  
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4.3 What Is OPC UA? 
OPC is a standards-based approach for connecting data 
sources (e.g., PLCs, controllers, I/O devices, databases, etc.) 
with HMI client applications (graphics, trending, alarming, etc.). 
It enhances the interface between client and server 
applications by providing a universally supported and well-
documented mechanism to communicate data from a data 
source to any client application.  
 
Included are not only a detailed guide on how to pass the 
data, but also specific information on other attributes to 
supplement those data, such as range information, data type, 
quality flags, and date and time information.  
 
OPC UA or "Unified Architecture" unites legacy OPC 
standards such as OPC-AE (Alarm & Events), OPC-DA (Data 
Access), and OPC-HDA (Historical Data Access) into one 
complete specification.  
 
The GENESIS64 automation suite supports these legacy 
protocols transparently, which incorporates newer 
communication standards while retaining backwards 
compatibility. 
 
Any OPC client application can connect to any OPC server. In 
other words, OPC offers true Plug-and-Play capability in the 
fields of HMI and industrial automation. OPC server types 
include OPC Data Access (DA), OPC Alarm and Events (AE), 
and OPC Historical Data Access (HDA) 
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4.4 Quick Start  
This chapter provides a brief overview of the following 
GENESIS64 products and tools: 

• GraphWorX64 
• AlarmWorX64 
• TrendWorX64 
• EarthWorX 
• GridWorX 
• Workbench 
• Additional tools and utilities 

Note: For complete information about any GENESIS64 
product, please refer to the GENESIS64 Help, which you can 
launch from any GENESIS64 product. 

4.5 GraphWorX64 
GraphWorX64 is the GENESIS64 product you use to create 
graphical human-machine interfaces (HMIs). GraphWorX64 
has dozens of tools with hundreds of parameters and 
combinations to create powerful, dynamic, and interactive 
images in two or three dimensions. Use the interactive 
tutorials in the GenDemo Learning Center (see the 
description in Section 3.1) to explore the tools that are 
available to you in GraphWorX64. 
 
To launch GraphWorX64 from the Windows Start menu, 
select Programs > ICONICS > GENESIS64 > GraphWorX64 
> GraphWorX64. 
 
GraphWorX64 has a number of examples available to you. To 
use them, while in GraphWorX64, select Open from the File 
menu and browse to the following directory: \Program 
Files\ICONICS\GENESIS64\GenDemo\. In this folder you 
will find subfolders with a name prefix of GWX_. Explore the 
folders and open example files to see what they offer. 
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4.6 AlarmWorX64  
AlarmWorX64 is the alarm monitoring, logging, and 
reporting module in GENESIS64. AlarmWorX64 consists of:  
• AlarmWorX64 Viewer – Which you use to configure 

real-time alarms and attach them to alarm sources; 
display alarm notifications; make it easier to notice, 
respond, and acknowledge alarm conditions; and view 
historical alarms.  

• AlarmWorX64 Server – Receives data from OPC-
compliant Data Access servers and performs alarm 
detection and reporting. 

• AlarmWorX64 Logger – Stores alarm data to a SQL 
database, which you can use for later replay. 

To launch AlarmWorX64 from the Windows Start menu, 
select Programs > ICONICS GENESIS64 > AlarmWorX64 > 
AlarmWorX64. AlarmWorX64 opens inside the Workbench.  
A presentation in GenDemo (see the description in Section 
3.1) provides an overview of AlarmWorX64. For a complete 
understanding of AlarmWorX64, access GENESIS64 online 
Help while in AlarmWorX64.  

4.7 TrendWorX64  
Use TrendWorX64 to plot real-time and historical OPC data 
into charts and graphs of all kinds, which you can then use as 
multifunctional HMI graphic displays. TrendWorX64 has a 
number of tools you can use to satisfy a wide range of 
applications. 
To launch TrendWorX64 from the Windows Start menu, 
select Programs > ICONICS GENESIS64 > TrendWorX64 > 
TrendWorX64. TrendWorX64 opens inside the Workbench.  
A presentation in GenDemo (see the description in Section 
3.1) provides an overview of TrendWorX64. For a complete 
understanding of TrendWorX64, access GENESIS64 online 
Help while in TrendWorX64.  
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4.8 EarthWorX 
Use EarthWorX to incorporate drill-down technology to 
quickly view alarm conditions for any location around the 
world, using maps available with Microsoft Bing. EarthWorX 
helps you to visualize geographically-dispersed assets (such 
as factories, facilities, or job sites) and track movable objects 
using GPS coordinates. 
A presentation in GenDemo provides an overview of 
EarthWorX. Instructions for using EarthWorX are available in 
GENESIS64 online Help.  

4.9 GridWorX 
GridWorX allows users to visualize, edit and update database 
tables through GENESIS64. Built in two parts the GridWorX 
Server can be found within Workbench, while the GridWorX 
Viewer can be added to GraphWorX64 HMI screens through 
the Controls tab of the GraphWorX64 Ribbon. 

4.10 Workbench 
The Workbench is the centralized Web-based interface in 
which you open GENESIS64 products and configure 
GENESIS64 components, runtime, and security. Every 
GENESIS64 component can be loaded, worked with, and run 
inside the Workbench. Projects can be packaged and 
deployed from inside the Workbench, too. 
When you select the Workbench command from the 
Windows Start menu the Workbench loads with all of the 
applications showing in the Project Explorer. It swaps in 
functions with each GENESIS64 product that you load in it. 
GENESIS64 providers can be opened from within the Project 
Explorer in the Workbench. 
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To launch the Workbench from the Windows Start menu, 
select Programs > ICONICS > Workbench. A presentation 
in GenDemo provides an overview of the Workbench. For a 
complete understanding of the Workbench, access 
GENESIS64 online Help while in the Workbench. 
 

4.11 Additional Tools and Utilities 
In addition to the many products and tools already described 
in this guide, there are additional tools and utilities are 
installed with GENESIS64. A brief description of each is 
described below. For more information about a tool or 
feature, refer to GENESIS64 online Help, which you can 
access from any GENESIS64 product or tool. 
• Use License Viewer (ICONICS Licensing > 

ICONICS .NET > Licensing > License Viewer) to review 
the status of your ICONICS licenses. 

• Use GenBroker64 to set up network communications 
to legacy OPC servers residing on other machines in the 
same network or the internet. (You don’t need 
GenBroker if you are talking to OPC UA servers.) You 
configure GenBroker properties from the FrameWorX 
Configurator, which you can launch by clicking Start > 
Programs > ICONICS  > Workbench and choose the 
FrameWorX Server Provider. Once the FrameWorX 
Configurator is open, expand the tree for the host and, 
below the “Classic OPC” item, double-click GenBroker. 

• Use Global Aliasing to set up aliases for use across 
GENESIS64 products. Click Start > Programs > 
ICONICS > Tools > Global Aliasing.  
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• Use Security to restrict operator and workstation 
runtime access. Privileges can be granted by a number 
of means, including application action, points, alarms, 
files, stations, and custom strings. To work with security, 
click Start > Programs > ICONICS >  
Tools > Security. 

• TraceWorX provides online diagnostics and tuning of 
applications running in GENESIS64. TraceWorX is 
intended for use by systems integrators, OEMs and 
customers who want to have tools for doing their own 
troubleshooting and diagnostics. To work with 
TraceWorX, click Start > Programs > ICONICS > Tools 
> TraceWorX. 

• Save implementation and development time by using 
the Unified Data Manager (UDM) to create libraries of 
reusable expressions, value sets, tag groups, alarm 
subscriptions, alarm filters, recipes, and event triggers 
across ICONICS products. To work with the UDM, click 
Start > Programs > ICONICS > Tools >  
Unified Data Manager. 

• Use the SNMP Connector to create, monitor, and 
manage your own Network Management Systems 
through GENESIS64, giving Network Managers access 
to information from nearly every device connected to 
the network, all from one application. To work with the 
SNMP Connector, click its button or icon in the Project 
Explorer in the Workbench. 

• Use the ICONICS BACnet Connector to integrate 
BACnet communications into the GENESIS64 and 
GENESIS32/Workbench32 product families. To work 
with the BACnet Connector, click its button or icon in 
the Project Explorer in the Workbench. 
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5 HYPER HISTORIAN 
5.1 Introduction 

Companies today are faced with the need to perform 
efficiently and competitively with fewer resources. For plant-
level operations, today’s systems need to connect to 
different infrastructures for data gathering and users need to 
analyze and visualize data in real time. Access to plant data is 
fundamental to staying competitive and efficient. The 
demand to produce products faster or streamline operations 
is increasing across the globe. ICONICS’ Hyper Historian™ 
enterprise-wide plant historian allows you to gain that 
competitive advantage, by organizing all your real-time 
information from across the enterprise. 
 
Hyper Historian is ICONICS’ high-speed, reliable and robust 
plant historian.  In order to analyze and visualize data in real 
time, organizations must have access to plant data and 
reporting. Hyper Historian is designed to log large volumes 
of data, in excess of 100,000 updates per second, and 
connects to multiple data sources across the enterprise 
including OPC UA, OPC DA, OPC XML DA, BACnet, SNMP 
and many more. ICONICS Hyper Historian also provides full, 
web-based configuration. Optional redundant configurations 
are supported using redundant Hyper Historian Collectors 
and redundant Loggers, and Hyper Historian offers Store and 
Forward technology as part of its integrated redundancy 
solution. 
 
Hyper Historian optionally utilizes an advanced Swinging 
Door algorithm to allow for high compression, and takes full 
advantage of 64-bit hardware and software architectures, 
enabling it to access more CPU power and memory than 
traditional 32-bit-based historians and providing highest 
performance possible.  
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The Swinging Door algorithm is available with configurable 
compression, but is based on a space-saving design that 
intelligently logs data without losing precision. 
 

5.2 What Is Hyper Historian? 
Features and Benefits of Hyper Historian include:  
• High Performance 64-bit Scalable Plant Historian 
• Archive and Compress Data at +250,000 Values/Second 
• Hyper to Hyper Distributed Solutions 
• Rich 2D and 3D Charts, Trends, Grids and Tables 
• Desktops, Browsers, Phones, and SharePoint Enabled 
• Performance Calculation Engine Delivers Advanced 

Analytics 
• Integrated Redundant Architecture for Mission-critical 

Solutions  
• Remote Collectors with Reliable Store-and-forward 

Technology 
• Accessible via SQL Query Language OPC HDA and APIs 
• Easily Merge Lab and other Offline Data with MergeWorX 
• OPC, OPC UA, BACnet, SNMP, SQL, and Web Services 
• Cloud Hyper Historian for Microsoft Azure  

 
Hyper Historian can use Swinging Door data compression for 
storing huge volumes of quickly changing data. But, even 
without the Swinging Door data compression, it is capable of 
logging in excess of 250,000 data events per second on 
reference hardware for real-time, enterprise-wide 
information. 
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Hyper Historian also has robust, built-in software 
redundancy for mission-critical applications that require 
uninterrupted access and collection of data. Automatic store-
and-forward technology ensure data integrity, in the event of 
system upset or communications disruption. 

 
Hyper Historian uses advanced data integration, providing 
unsurpassed connectivity to any device via OPC UA,  
OPC HDA, OPC XML, SNMP, BACnet or database values. 
Users can easily collect information from multiple plants, 
facilities or throughout the enterprise.  
Data sources such as PLCs, I/O devices, HMI applications and 
network devices can be collected and stored for reporting 
and analysis. 
 
Hyper Historian includes an industry standard SQL Query 
interface, enabling tight integration with Microsoft SQL-
compatible database such as Microsoft SQL Server. Hyper 
Historian also has a unique, automated archiving feature that 
allows for routine or triggered scheduling of data archives, 
freeing up disk space and backing up files for long-term 
storage and/or retrieval. 
 
The Workbench inside Hyper Historian features a thin client, 
optimistic concurrent design, acting as the central 
configuration environment and operator interface. The 
runtime operational interface allows for complete 
visualization of real-time and historical data with 2D and 3D 
charts. The Workbench’s advanced configuration console 
performs complete service management and has integrated 
layout/project management and remote pack-and-go 
deployment capabilities. 
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From the Workbench, operators can add fully customizable 
3D trends and charts. Users can choose from a wide library 
of 3D charts such as X vs. Y, logarithmic, bar graph, strip 
chart recorder, circular and more, to build clear and accurate 
representations of real-time and historical data. Intuitive 
ribbons and galleries help to customize trends by adding 
color, gradients, smooth animation, translucency/glass 
effects, anti-aliasing and more, making data analysis clear 
and straightforward. Users can drag and drop sources during 
runtime and view multiple trends simultaneously. 
 
Users can trend production numbers against a target. Data 
can also be exported in tabular formats and it is possible to 
enter operator comments, as well as manage lab data and 
audit trails in accordance with FDA 21 CFR Part 11 policies. 
 
Hyper Historian can also connect with the entire ICONICS 
BizViz Manufacturing Intelligence/Business Visualization 
suite, to create best-in-class reporting, analysis, portal or 
data bridging applications. 
 
For additional information about ICONICS products, please 
visit the ICONICS website at www.iconics.com. 

5.3 Hyper Historian Configuration - Workbench 
Hyper Historian is configured through the Workbench, an 
integral part of Hyper Historian and ICONICS’ GENESIS64 64-
bit, OPC-integrated, Web-enabled HMI/SCADA suite. 
Workbench is loaded as part of the Hyper Historian 
installation and is a multi-functional, centralized, web-based 
environment for product configuration.  
The Workbench can also act as an advanced operator 
interface for visualization and service management and has 
integrated layout/project management and remote, pack-
and-go deployment capabilities. 

http://www.iconics.com/
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5.4  Starting the Hyper Historian Configuration 
Workbench 

If you wish to launch directly from your desktop, click Start, 
then All Programs, then select ICONICS Product Suite > 
Workbench from the list. 
 
If you already have a component running with Workbench, 
select Historical Data > Hyper Historian. 

5.5 Using the Hyper Historian Configuration 
Workbench 
Starting and Stopping the Hyper Historian Logger 
The Hyper Historian Workbench contains a stoplight icon in 
the ribbon that lets you start or stop the Hyper Historian 
service. 
  
If you are using Hyper Historian Standard Edition, the 
stoplight will start or stop the high-speed, in-process version 
of the Hyper Historian Logger and Collector.  
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If you are using Hyper Historian Enterprise Edition, by default 
the stoplight will start or stop the OPC UA-based Hyper 
Historian Logger and Collector, which allow for remote data 
collection and redundancy support. 
 
Users of the Enterprise Edition also have the option of 
running the In Process version of the Logger and Collector, if 
redundancy and remote data collection are not required. 
 
Configuring the Hyper Historian Logger to AutoStart 
 
From within the Workbench, select your project name in 
Project Explorer, then click the Configure Services button or 
icon in the Home tab. Scroll to the ICONICS Hyper Historian 
Logger service, and change the Start Mode to Auto. Other 
options are Manual, Auto (Delayed) and Disabled. 
 
Next to the Start Mode column is the Status column which 
can be in Running, Stopped, or Start (Pending) modes. To 
change the Status of a service, click the traffic light icon in 
the left column. You have the option to either Start or Stop 
the Status. 

 
Viewing Licensing Information 
 
In the Hyper Historian Workbench, you can see the License 
Viewer by clicking the Licensing button in the Tools menu. 
The License Viewer tab then appears in the Workbench.  
 
Using TraceWorX 
 
To enable TraceWorX, click the TraceWorX button in the 
Tools menu. The TraceWorX window appears, as shown 
below. You can then select trace levels for each of the 
available modules. 
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Configuring TraceWorX 
 
To configure TraceWorX, select the trace level for the 
intended module. There are several trace levels, show in the 
image below. 

 
 

Viewing TraceWorX Generated Log Files 
 
To view TraceWorX generated log files, go to the Current 
Log tab by clicking the button in the Current Log column 
and selecting View Log. A separate window opens showing 
the log files that are contained in that module. 
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5.6 Initial Hyper Historian Setup 
 

Before using the Hyper Historian for the first time, you 
should use the Historical Data > Hyper Historian > System 
Administration > System Settings > File Logger tab to set: 
  
• Data Store Directory  
• Archive Data Store Directory 
 
The Data Store Directory is the location where the Hyper 
Historian stores the plant data it collects. The default folder 
for the Data Store Directory is 
C:\ProgramData\ICONICS\HyperHistorian\Data\ 
Data Logger.   
 
It is important to change this default path, especially if the C: 
drive has a low amount free storage space. 
 
The Archive settings tell the Hyper Historian whether it is to 
automatically detach older data from the system, and if it is 
to remove the old data, the folder location it should move 
this data to.  
 
The rest of the system settings have default values that 
facilitate the initial start-up and operation of the Hyper 
Historian. For more information on the other settings, refer 
to “Configuring System Settings” in this guide. 
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5.7 Hyper Historian Tag Organization 
 

The primary element for the grouping of tags is the logger. 
For each logger that is created, Hyper Historian creates a 
series of similarly named binary files to hold the plant 
historical data. The file creation and automatic archiving 
functions are based on the logger. You may create multiple 
loggers. 
 
 
Before you begin, analyze the data you want to collect and 
how long you want the data to be kept online in Hyper 
Historian. Data that is kept online for longer periods of time 
should be grouped together in one logger. Data that is to be 
kept online for shorter periods of time should be grouped in 
a second logger, and so on. For example, if you want to have 
some data kept online for a year, some data for three 
months, and some for one month, you should create at least 
three loggers, one for each of the desired time ranges. 
 
Loggers are made up of one or more logging groups. Each 
logging group may contain one or more collector groups 
and/or aggregate groups. The collector and aggregate 
groups are made up of tags, whose data is to be logged.  
Note: Logging groups can be enabled or disabled using the 
Configurator, and can be enabled or disabled online as well. 
 
 
 
 
 
 
 
 



Hyper Historian ICONICS Product Suite Getting Started  

 ICONICS 5-10 

5.8 Configuring a Hyper Historian Logger 
 
To add a new logger, drill down Historical Data > Hyper 
Historian and right-click the Loggers & Groups section and 
select + Logger. Each Logger creates a data file on the hard 
drive to store the collected plant data.  
 
You will need to specify the conditions for when the Hyper 
Historian should create a new data file and close the current, 
existing file. This is used to control the amount of plant data 
or the time frame for the plant data that should be logged to 
each file. The conditions can be based on a time period, file 
size or a Unified Data Manager triggered event. 
 
The Unified Data Manager (UDM) can be used to schedule 
the creation and closing of files based on calendar (date) and 
Time of Day. In addition, the UDM can be used to trigger file 
closure based on an external event. To use a UDM trigger to 
schedule or trigger the file creation, browse for the UDM 
triggers using the ellipsis button […] on the right side or type 
in the specific trigger name. 
 
Refer to the Hyper Historian online Help for more 
information about how to configure a Disk Logger and set 
up archiving for it. 
 

Deleting a Hyper Historian Logger 
 
Before deleting a Hyper Historian Logger, you should first 
verify that there are no Logger Groups using the Logger that 
is to be deleted. If any Logger Groups are assigned to the 
Logger, they need to be deleted or assigned to another 
Logger first.   
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Once you delete a Logger, the data that was previously 
logged as part of the group will no longer be available for 
playback in the trend display nor in the SQL Query Interface.  
 
To delete a logger, right-click it, and then select Delete from 
the menu. You will see a confirmation dialog box prompting 
you to proceed. 
 

Managing Data Storage 

Backing Up the Hyper Historian Configuration Database  

It is highly recommended that you back up all of the Hyper 
Historian and SQL databases in the following circumstances:  

• Before you make any changes to the database, in case 
you want to return to the original configuration. 

• On a regular schedule, to minimize data loss in the 
event of a disk failure. The best way to perform 
database backups is to set up automatic backups using 
SQL Server Management Studio. You should back up 
your database at least once a week. 

When you perform a database backup, all system tables, 
user-defined objects and data are copied to a separate file 
located on a backup device. Backup devices include disk files, 
floppy diskettes, zip disks, and tape drives. Backups can be 
easily managed using the SQL Server Management Studio. 
The master and msdb databases should be on the same 
backup schedule as the Runtime database.  
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Backing Up the Database  

Note: Any transactions that are in progress when the backup 
is performed are rolled back if that backup is later restored.  

To back up the database  

1. In Microsoft SQL Server Management Studio, expand 
Databases and select Hyper Historian. 

2. Right-click the IcoUnifiedConfig (or however you 
named your database) database, point to Tasks, and 
then click Back Up…. The Back Up Database dialog 
box appears.  

3. Click the General tab. In the Database box, select 
IcoUnifiedConfig. 

4. To use an existing backup device or file for the backup, 
select the destination in the Destination area and then 
click OK to begin the backup.  

For details on a particular backup destination, select the 
destination in the list and then click Contents.  

5. If you do not have a backup destination defined, click 
Add to add a new destination. The Select Backup 
Destination dialog box appears.  

6. Select to back up to either a file or device.  
• To back up to a file, type or browse to a path for 

the location of the backup file. Be sure that you 
have enough free disk space to store the backup.  

• To back up to a backup device, select an existing 
backup device or select <New Backup Device>.  
 
 



ICONICS Product Suite Getting Started MobileHMI 

ICONICS 5-13 

The Backup Device Properties dialog box 
appears. In the File name box, type a name for the 
device. As you type the name, the path for the 
backup will be modified.  

• Verify that the path for the backup is correct. 
When you are done, click OK to create the backup 
device.  

7. Click OK to close the Select Backup Destination dialog 
box.  

8. The newly-created backup device now appears in the 
Destination window of the SQL Server Backup dialog 
box. Select the new backup device.  

9. Click OK to perform the backup.  

You can configure various options for database 
backups, such as an expiration date for a backup. You 
can also schedule automatic backups.  

For a complete description of database backup and 
restoration using SQL Server Management Studio, 
including scheduling recommendations and transaction 
log backup, see your SQL Server Management Studio 
documentation.  
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5.9 Configuring a Hyper Historian Logging Group 
To edit or add a new Hyper Historian Logging Group: 
 
1. Drill down Historical Data > Hyper Historian and 

right-click the Loggers & Groups section and select the 
Logger for the group. Then click + Add Logging 
Group. Enter the name of the Logging Group. 

2. Ensure the Enabled checkbox is checked. 
3. Select the Logger that this Logging Group is to belong 

to from the Snapshot Logger drop-down list. 
4. Click the Apply button. 

 

5.10 Configuring a Hyper Historian Collector 
Group 
To edit or add a new Hyper Historian Collector Group: 
 
1. Drill down Historical Data > Hyper Historian > 

Loggers & Groups and select the Logger and Logging 
Group for the Collector Group to be created. Then click 
+ Add Collector Group. Enter the name of the 
Collector Group. 

2. Select the Collector from which this Collector Group is 
to get its data from the drop-down list.   

3. If the Collector overwrites Source Timestamp of data 
with its actual UTC time is checked, the Hyper 
Historian logger applies its own time stamps to the 
collected data instead of using the time stamps 
provided by the OPC Server. This feature can be used if 
the OPC Server cannot provide accurate or reliable time 
stamps.   

4. Specify the Data collection rate. The data collection rate 
is the rate at which the Collector collects the raw data 
samples from the data source. 
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5. Specify the Calculation period. The Calculation period is 
the frequency of which the Collector is to perform its 
Advanced Filtering calculations for the tags within this 
group. (For more information on the Calculation period,  
see “Logging Options Configuration” later in this 
section.   

6. If you wish to set a Collecting Condition, click the 
Collect On Condition checkbox. The condition can be 
based on a Unified Data Manager trigger. To select a 
UDM conditional trigger, browse for the trigger by 
clicking the ellipsis button […] on the right side, or type 
in the trigger name. 

7. Enter the Description of the Collector Group. 
8. Click the Apply button to save the changes. 

 
The Refresh button refreshes the screen with the current 
configuration settings for the collector group by reading it 
from configuration database. 

 
Once the Collector Group has been created, you can access 
further options by right-clicking the group in the left-side 
navigation pane. Options include Edit, Delete, Paste, Cut, 
Copy, Multiply, Refresh, and Refresh Parent. 
 

5.11 Configuring a Hyper Historian Tag 
To edit or add a new Hyper Historian tag to collect data from 
a signal: 
 
1. Select the Data Collections section of the Hyper 

Historian Project Explorer and click + Tag to add a tag. 
This opens the New Tag tab.  
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To create a folder of tags, click + Folder instead. There 
are also buttons to add specific types of tags, calculated 
conditions or events, or add multiple tags at once. 

2. Enter a name for the tag. 
3. Select the signal to be logged by clicking the ellipsis 

button […] to the right of the Signal Name field and 
browsing for the tag whose data is to be logged. 

4. Enter a Description for the tag. 
5. Select the Collector Group this tag belongs with in the 

In Group field. 
 

6. Select the Data Type from the next drop-down list. 
Options include: Native, Boolean, Int8, UInt8, Int16, 
UInt16, Int32, UInt32, Int64, UInt64, Float32, Float64, 
String, DateTime, and Duration. 
 
Note: Hyper Historian requests the selected data type 
from the data source (that is, the OPC server). The 
UInt64 and Float64 data types are not supported by 
OPC DA Servers running on Windows 2000. 

7. Click the Support Operator Comments to enable this 
feature if it is desired. 

8. Select the Stepped Interpretation option if desired. 
9. Enter the Engineering Units. 
10. Enter the ranges for the Range in the provided text 

entry fields. Note, these limits are used by the filter 
algorithms. For more information, see the “Deadband 
Filter Configuration” and “Swinging Door Filter 
Configuration” sections in this guide for information on 
how the limits are used. 

11. If desired, apply Filtering to the tag by selecting either 
Deadband or Swinging Door in the Filter Type 
dropdown menu. 

12. If you enabled a Deadband filter, select the type of 
deadband filter to be used (Absolute or Percentage) 
and enter the filter setting. 
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13. If you enabled a Swinging Door filter, enter the 
Threshold settings and the Period settings. 

14. Open the Logging Options tab of the dialog and select 
the Aggregate Type option. You can request that all 
collected raw samples be logged, or you can 
alternatively request the Hyper Historian to perform an 
advanced filter. The Advanced Filter options include 
Moving Minimum, Moving Average and Most Recent 
On Time.  
 
If you choose an advanced filter such as the Moving 
Average, the Hyper Historian collector will perform the 
Moving Average calculation on the raw samples over 
the defined calculation period (defined when setting up 
the Collector for the tag). The result of the calculation 
will be logged at the end of each calculation period. 

15. The Aggregates tab is described later in this section 
where aggregate folders and aggregate tags are 
described. For information about the Tag Logging 
Options tab, refer to the Hyper Historian online Help. 

16. Click the Apply button to save the changes. 

Logging Options Configuration 
The Logging Options configuration allows you to 
specify if all samples collected by the Collector are to be 
logged to disk or if the collector is to aggregate 
samples instead. The Aggregate Type options include: 

• All Samples 
• Max (Maximum) 
• Min (Minimum) 
• Avg (Average) 
• Std. Dev (Standard Deviation) 
• Running Max 
• Running Min 
• Running Avg 
• Moving Avg 
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• Moving Max 
• Moving Min 
• Totalizer 
• Most Recent On Time 

 
The calculation period for the Aggregate Type is 
specified in Collector group configuration.  

Deadband Filter Configuration 
The Deadband filter is performed by the Collector on 
incoming data. It serves as the front-line for all of the 
filtering logic. The deadband filters out values based on 
difference of values of consequent changes – if the 
difference is below a defined threshold, new value is ignored. 
 
Parameters:   
 
Deadband configuration is straightforward: 
• It can be either disabled or enabled 
• If enabled, it is possible to configure its range 

o As an absolute value (non-negative) 
o As a percentage of value range (max - min) 

defined for the tag 
 
Note that the value configured is the minimum 
difference between values to allow subsequent values 
to become a “base value” for deadband ranges. Actual 
range around base value spans both up and down. 
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Swinging Door Filter Configuration 
 

The Swinging Door filter is a generalization of a deadband 
filter. It is implemented by the Logger on incoming values it 
receives from the Collector. It serves as the last-line of the 
filtering logic. The swinging door filters values based on 
difference of later values based on a linear trend – if the 
difference is below a defined threshold, any new values are 
ignored. 
 
Detailed operation 
 
Swinging door filters values that follow certain linear trends. 
It starts with one value (the first one is always forwarded to 
storage). 
 
Two tangents are considered, originating above and below 
the base value in a defined filter range. Tangents are 
effectively defined by second value in filter. As the Logger 
processes subsequent values, the tangents are adjusted to 
form a geometrical region encompassing all values in filter 
so far.  
 
Geometrically, as long as tangents don’t intersect prior to the 
base value (i.e. the region defined by tangents is not 
broadening – hence the commonly-used filter name), the 
filter is valid.  
 
When new value causes the region to open up, the filter is 
flushed – the last value prior to breaking one is dumped to 
storage and the filter is reinitialized using that value and the 
breaking one. 
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There are certain guarantees about the maximum deviation 
of filtered values (the difference of ignored values from the 
stored trend can’t be higher than the distance between 
points used to draw tangents above and below the base 
point, for example). 
 
Parameters:  Filter configuration is similar to deadband’s: 
• It can be either disabled or enabled 
• If enabled, it is possible to configure its range 

o As an absolute value (non-negative) 
o As a percentage of value range (max - min) 

defined for the tag 
 

Besides these parameters, there are two additional ones: 
• Minimum distance between values 

o If two subsequent values are closer (time-wise) 
than defined threshold, the new value is ignored 

• Maximum distance of values 
o If the distance between the last stored value 

(physically) and an incoming value is higher (time-
wise) than defined threshold, the filter is flushed as 
if the new value would be one to break the filter. 

Calculated Tags 

In Hyper Historian, you can use calculated tags and 
calculation triggers to configure complex calculations. You 
can use performance calculations to provide totals over time 
or statistics for analysis. These calculations are performed 
only on historical data stored in Hyper Historian.  

You can also use these calculations for setting up alarms or 
faults for certain conditions that may occur over time.  
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For example, you may want to schedule maintenance for a 
machine every 10,000 hours of run time or every 1,000 
cycles. In this case, you can create a calculation tag that 
calculates the amount of time the tag is in the TRUE state, 
and another calculation tag that counts the number of times 
the machine has been switched on. A third calculation tag 
can monitor the incoming values for the first two tags, and 
can generate an alarm when a predetermined threshold has 
been reached for maintenance.  

Performance calculations can be triggered periodically or on 
any data change event, using a flexible new date/time and 
many different mathematical, string and historical data 
retrieval functions that are part of the ICONICS Expression 
Editor. Calculations can use scalar values, historical values, or 
string operations, along with a wide variety of functions 
within an enhanced version of the ICONICS Expression 
Engine, and results are calculated automatically on each 
trigger, or can be recalculated manually on demand. 

Calculated tags take as their input normal incoming values 
from Hyper Historian tags and perform calculations on 
historical data. The results of these calculations are stored in 
the Hyper Historian database. You can nest calculated tags 
so that they can be used as input to other calculated tags. 
These calculations are triggered using calculation triggers -- 
these are triggers that are created specifically for use with 
calculated tags. Calculation triggers are different than regular 
triggers because they can point to historical dates and times, 
whereas regular triggers cannot.  

Calculation triggers also make use of special functions that 
are available only to them, for use with calculation tags.  
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Configuration of a new Performance Calculation tag is easy. 
Simply add a new Calculated Tag in the existing hierarchical 
structure of the Hyper Historian Workbench configurator; 
you can organize calculated tags in folders and subfolders.  

Each Performance Calculation appears as a new tag in the 
Hyper Historian browser, and can therefore be accessed, 
replayed, analyzed, and reported on just like other Hyper 
Historian data values. 

Hyper Historian offers several preconfigured calculations 
out-of-the-box such as standard deviation and variance, and 
you can customize your own Performance Calculations using 
the Expression Editor, with equation parsing and syntax 
checking. 

 To configure calculated tags you must do the following:  

• Add calculated tags to the folders where you store your 
Hyper Historian tags. 

• Create calculation triggers that will execute the 
calculations, and add these triggers to your calculated 
tags. 

• Set up recalculation options in the System 
Administration node. 

Configuring a Calculated Tag 

To create a calculated tag in Hyper Historian, follow the 
steps on the following pages. Each calculated tag that you 
create will store calculated values in the Hyper Historian 
database. You will be creating the calculated tag in the folder 
where the Hyper Historian tags you will be using as input are 
located. This is for organizational purposes only.  
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The calculated tags that you create can reside anywhere in 
the Data Collections node. In fact, you can put them into a 
folder of their own if you like.  

1. In the Workbench, make sure you are looking at the 
Hyper Historian provider. Expand the Data Collections 
node so that you are in the folder where you want to 
create the calculated tag.  

3. Right-click the folder where would like to add a new 
calculated tag, and select Calculated Tag, as shown 
below. This opens the Calculated Tag window with the 
Properties tab on top.  

4. In the Hyper Historian Calculated Tag form that opens 
(shown in the following figure), enter a name and 
display name for the calculated tag.  

Leave the Enabled checkbox unselected until you are 
ready to begin using the calculated tag. Enter a 
description that describes how the calculation is used; 
include information that will be helpful for later 
maintenance of the tag. 

5. Put a check mark next to Stepped interpretation to 
enable this feature if it is desired. The Stepped 
Interpretation check box is used primarily during 
playback, for interpreting the tag’s data values. This 
feature is applied only if you request a value for a 
certain point of time. The returned value will be the 
nearest older value available. In general, if the data 
comes from a discrete signal such as an on/off switch 
(or a Boolean data type), put a check mark in this box; 
but if data comes from a sine wave or analog signal, 
leave the box empty. 
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6. You can optionally put a check mark in the Support 
Operator Annotations check box to allow operators to 
comment on the signal in displays. Later, as the tag’s 
data values play or replay in the Trend Viewer, you may 
want to be able annotate the tag’s data values as you 
see them trending before you.  
 
For example, you may want to note an operator action 
that altered the data slightly, or highlight a piece of 
data for analysis later.  
 
Putting a check mark in the Support Operator 
Annotations check box allows you to do that. Such 
annotations are saved with the tag’s data in its logger 
file, which makes the annotations available in a replay, 
accessible to the Hyper Historian SQL Server Interface, 
and archived with the tag’s data. 

7. Select the data type from the Data Type drop-down 
menu. Among the options available to you are: Native, 
Boolean, Int8, UInt8, Int16, UInt16, Int32, UInt32, Int64, 
UInt64, Float32, Float64, String, DateTime, and Duration.  

8. Enter the Range of acceptable values for the data. 
These values are used by the filter algorithms to remove 
anomalous data. 

9. Enter the engineering units. 
10. In Min. Sample Distance, specify the minimum 

amount of time between samples. This option is helpful 
for limiting samples from high-frequency sampling.  

11. In the Triggers section, add the triggers that determine 
when the calculations will occur. The triggers that you 
can add here are calculation triggers that must be 
predefined as described in the “Creating a Calculation 
Trigger” topic that follows. Note that you can use the 
Up and Down buttons (on the right) to sequence 
triggers in the list.  
 

mk:@MSITStore:C:/Documents%20and%20Settings/Russell%20D/Desktop/GENESIS64.chm::/Apps/HH/Creating_a_Calculation_Trigger.htm
mk:@MSITStore:C:/Documents%20and%20Settings/Russell%20D/Desktop/GENESIS64.chm::/Apps/HH/Creating_a_Calculation_Trigger.htm


ICONICS Product Suite Getting Started MobileHMI 

ICONICS 5-25 

The sequence becomes important only when two 
triggers execute at the same time; the trigger that is 
higher in the list will execute first.  

12. Now go to the Expression tab to create an expression 
for the calculation. This expression may include the 
following: 

• The tag or tags whose data is to be used as 
input to the calculation. This can include 
values from Hyper Historian tags and signals 
as well as values from other calculated tags.  
 
Clicking the Variables button will open a 
dialog box that lets you choose any tag that 
is in the Hyper Historian tree in Project 
Explorer.  

• The historical time frame from which data is 
to be taken.  The time frame should be 
relative to the execution date and time 
determined by the triggers. Do not hard code 
dates into the expression unless you always 
want those exact dates to be used for the 
calculation.  

• Any additional selection criteria to be used.  
• The calculation to be performed. Click the 

Arithmetic, Relational, Logical, Bitwise, and 
Functions buttons to incorporate 
syntactically correct elements into the 
calculation. Note that a number of functions 
that are specific to calculated tag logic have 
been developed for use.   

12. Click the Syntax button at the bottom of the window to 
check the logical syntax of the expression. Make any 
necessary corrections.  
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13. When you are satisfied with the calculation, make sure 
you put a check mark in the Enabled check box.  

14. Click Apply when you are done.  
15. At this point you can test the calculated tag to make 

sure the expression is calculating the result you are 
looking for. 

Creating a Calculation Trigger 

In Hyper Historian, you create calculation triggers that cause 
the Performance Calculation Engine to evaluate calculated 
tags. (For more about calculated tags and their use, refer to 
the previous Calculated Tags topic.) Once you have created a 
calculation trigger, you can add it to the calculation tags for 
which it will execute calculations. 

Calculation triggers are much like regular Unified Data 
Manager (UDM) triggers except that they are designed to 
work with historical data. This topic describes how to create 
time triggers and data triggers for use with Hyper Historian 
calculated tags.  

As you can see in the figure below, calculation triggers get 
their own Calculation Triggers node in the Hyper Historian 
tree structure in the Workbench Project Explorer. This is 
where you will create and store the calculation triggers that 
you create for executing calculations for calculated tags.  

In the Calculation Triggers node, notice that Periodic triggers 
are identified with a clock icon, and Sample Triggers with a 
"X=" icon. This topic describes Periodic Triggers for 
Calculated Tags and Sample Triggers for Calculated Tags.  
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5.12 Periodic Triggers for Calculated Tags 

A Periodic trigger defines specific times at which the trigger 
is to fire. When you add a Periodic trigger to a calculated tag, 
the tag's calculations fire at the times indicated by the 
Periodic trigger. The calculated tag can have any number of 
triggers associated with it, but a trigger must be enabled in 
order to fire. If it is not enabled, it won't fire.  

To create a Periodic trigger for calculated tags in Hyper 
Historian, follow these steps: 

1. In the Hyper Historian Project Explorer in the 
Workbench, expand the tree so you can see the 
Calculation Triggers node.  
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2. Right-click the Calculation Triggers node and select  
+ Time Trigger. The Hyper Historian Time Periodic 
form opens, as shown below.  

 

3. Enter a name and display name. Enter a description that 
aptly describes the trigger and how it is used. 

4. Enter a Processing Phase, which determines this 
trigger’s relative priority in the event that multiple 
triggers are activated at the same time. 

5. Specify whether the trigger runs based on UTC time or 
local time on the server.  

6. For the Recurrence Type, specify whether you want the 
trigger to run at a specified Time Interval, or on 
Specific Dates and Times. For more information, refer 
to the Time Trigger Options topic for the UDM.  

7. Click the Preview button to see a display of the exact 
times at which the time trigger will fire.  
 
Previewing the times is helpful if you are configuring a 
complex recurrence pattern; it can help you to 
understand whether you have configured it properly or 
not.  

8. When you are done, make sure that the Enabled check 
box is checked and click Apply.  

mk:@MSITStore:C:/Documents%20and%20Settings/Russell%20D/Desktop/GENESIS64.chm::/Com/Tools/Data/UDM10001010_Time_Triggers.htm#Time_Trigger_Options
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9. Now you can associate the trigger with a calculated tag 
as described in the process for “Configuring a 
Calculated Tag” above. 

5.13 Sample Triggers for Calculated Tags 

When you add a Sample Trigger to a calculated tag, the tag's 
calculations fire when the value of a data point equals a 
specified value or condition. For example, it can fire when a 
machine switch gets set to on, or TRUE. A calculated tag can 
have any number of triggers associated with it, but a trigger 
must be enabled in order to fire. If it is not enabled, it won't 
fire.  

To create a Sample Trigger for calculated tags in Hyper 
Historian, follow these steps: 

1. In the Hyper Historian Project Explorer in the 
Workbench, expand the tree so you can see the 
Calculation Triggers node.  

2. Right-click the Calculation Triggers node and select  
+ Data Trigger. The Hyper Historian Sample Trigger 
form opens, as shown in the following image.  

 

3. Enter a name and display name. Enter a description that 
aptly describes the trigger and how it is used. 
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4. Enter a Processing Phase, which determines this 
trigger’s relative priority in the event that multiple 
triggers are activated at the same time. 

5. In the Trigger On drop-down list, choose the condition 
in which the trigger is to fire. The trigger can fire upon 
Any Datapoint Change or using an Expression in 
which you can specify any condition to execute the 
trigger. For more information about creating an 
expression that fires, refer to the “Expression Editor” 
topic in your Hyper Historian online help 
documentation.  

6. In the Data point field, specify the tag for the data 
point to be tested by the trigger.  

7. Specify whether you want to ignore Bad or Uncertain 
quality tags.  

8. When you are done, make sure that the Enabled check 
box is checked and click Apply.  

9. Now you can associate the trigger with a calculated tag 
as described in the process for “Configuring a 
Calculated Tag”. 

Organizing Tags into Folders 
 

A Hyper Historian folder can be useful to gather individual 
Hyper Historian Tags. To add a new folder: 
 

1. Right-click a Data Collection and select + Folder.  
2. Enter a name in the text entry field and a 

description.  
3. Click Apply or Refresh to proceed. 

 
You can now create a Hyper Historian tag on the same level 
of the Data Collection or within a newly created Hyper 
Historian folder. Right-click either a data collection or a 
hyper historian folder and select Tag to proceed. 
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5.14 Configuring a Hyper Historian Aggregate 
Group 

In this version of Hyper Historian, an aggregate group 
represents an interval for collecting data from one or more 
OPC tags in a logging group. For example, you may have a 
logging group for which you want to collect data every 2 
minutes, every 30 minutes, every 12 hours, at the end of each 
day, and at the end of each week – so you would create an 
aggregate group for each of these time intervals. 
 
To edit or add a new Hyper Historian Aggregate Group: 
 
1. To add an Aggregate Group, navigate to the Loggers & 

Groups area in the Hyper Historian Project Explorer, 
right-click the Logging Group, then click +Aggregate 
Group. 

2. Enter the name of the Aggregate Group. 
3. Specify the Calculation Period. The calculation period 

is the interval at which of which the Hyper Historian 
Logger is to perform the aggregate calculation. 

4. Specify the Percent Good amount that the data must 
satisfy for the aggregate to be considered “good,” as 
well. 

5. Decide whether you want to treat uncertain data points 
as bad. 

6. Enter a Description of the Aggregate Group. 
7. Click the Apply button to save the changes. 
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5.15 Configuring a Hyper Historian Aggregate Tag 
Behavior of Aggregate Tags 
 
Hyper Historian provides functionality to evaluate OPC HDA 
aggregates of managed tag data on the fly – each such 
configured evaluation is called an aggregate tag. An 
aggregate tag is defined in the tag configurator using the 
Aggregates tab; here you simply define the aggregate 
groups to be used for an OPC tag. (Aggregate tags no longer 
appear as nodes in the navigation tree.) 
 
The aggregate tag’s name is generated automatically, using 
the aggregate evaluation properties (the name of 
aggregation type and the sampling rate) that you define for 
it. The aggregate name abbreviates these properties, so a 
longer, more descriptive Display Name is available, too. 
 
When a new aggregate tag is defined, its values may get 
evaluated backwards as well, depending on the value of 
ancestor sampling group’s property “recalculate all”; 
however, changing the property value has no effect on 
currently defined tags. 
 
You have the option of disabling an existing aggregate tag’s 
evaluation so that its value changes are ignored. Note that a 
disabled aggregate tag can be re-enabled again at any time. 
 
Evaluation of Sampled Data 
 
The Aggregate Tag evaluation runs in the background 
independently, and its results are stored in the Hyper 
Historian logger based on the parameters defined for it. The 
evaluation abides to simple rules: 
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• Evaluation logic monitors incoming data values and 
reevaluates aggregates whose values might change as a 
result of changed source data. 

• The evaluation is performed periodically on specified 
time intervals where data is detected as changed since 
the last evaluation; the initial evaluation of an interval 
occurs with at least a 1 minute delay. 

• Sampling intervals are aligned to the nearest earlier 
occurrence of the nearest higher time bin boundary. For 
example, a sampling rate of seconds yields sampling 
intervals aligned to a minute – having a sampling rate 
of 5 seconds yields intervals starting at +0, +5, 
+10…+55 seconds within a minute.  

• Note, however, that sampling rate value that is not a 
divisor of the given time bin may yield anomalies in 
sampling interval alignment during re-evaluations. For 
that reason, you should restrict available sampling rates 
to divisors. 

 

Aggregate Tag Configuration  
 
To edit or add a new Hyper Historian Aggregate Tag: 
 
1. Double-click the Hyper Historian tag for which you 

want to define aggregates. The tag’s configurator 
opens. 

2. Select the Tag Aggregates tab. Here you can define 
any number of aggregates to be collected for the Hyper 
Historian tag. For each aggregate, specify the 
information described in the steps that follow. Note 
that an informative Aggregate Name and longer 
Display Name are generated for you automatically.  

3. Select the Enabled check box to collect data for the 
aggregate. 
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4. Select the Aggregate Type. The following types of 
aggregates are supported by the Hyper Historian: 
• Annotation Count 
• Average 
• Count 
• Delta 
• Delta, with bounds 
• Duration Bad 
• Duration Good 
• End 
• End, with bounds 
• Interpolative 
• Maximum 
• Maximum Actual Time 
• Maximum Actual Time, with bounds 
• Maximum, with bounds 
• Minimum 
• Minimum Actual Time 
• Minimum Actual Time, with bounds 
• Minimum, with bounds 
• Number Of Transactions 
• Percent Bad 
• Percent Good 
• Population Standard Deviation, N 
• Population Variance, N 
• Range 
• Range, with bounds 
• Sample Standard Deviation, N-1 
• Sample Variance, N-1 
• Start 
• Start, with bounds 
• Sum 
• Time Average, with bounds 
• Time Average, with complex bounds 
• Total 
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• Total, with bounds 
• Worst Quality 
• Worst Quality, with bounds  

5. Select the Aggregate Group that has the calculation 
interval you want to use for the aggregation. If you 
don’t see the group you are looking for in the drop-
down list, click the Refresh Aggregate Groups button, 
then try again. The Aggregate Group must be created 
before it can be selected. 

6. You can optionally set an override (in hours, minutes, 
and seconds). To do so, put a check mark in the 
Override Calculation Period check box in the Logging 
Options tab and set the hours, minutes, seconds and/or 
milliseconds for the override. 

7. Click the Apply button to save the changes. 
 

5.16 SPC Configuration in Hyper Historian 
For Quality AnalytiX customers, SPC configuration is included 
in your installation of Hyper Historian. This enables you to 
configure rules and tags related to SPC charts that monitor 
the capability and reliability of your system. You first 
configure rules that you then apply to specific tags that you 
configure for display in SPC and histogram charts. 
For more in-depth instructions regarding the configuration 
of SPC distribution rule sets and tags, consult your online 
documentation for Hyper Historian or Quality AnalytiX. 
Configuring SPC Distribution Rules 
To configure an SPC distribution rule in Hyper Historian: 
1. Navigate to the SPC Distribution Rules area of the Hyper 

Historian Project Explorer. 
2. Right-click the “SPC Distribution Rules” folder and select 

+ SPC Distribution Rule Set. 
3. Enter a name and a description for the rule set. 
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4. In the Rules area, click the “Enabled” check box to add a 
rule to the rule set. 

5. Specify one of the following rule types: 
a. Outside Sigma Limit 
b. Outside Upper Sigma Limit 
c. Outside Lower Sigma Limit 
d. Outside Sigma Limit Single Side 
e. Trending 
f. Trending Up 
g. Trending Down 
h. One Side Of Center Line 
i. Above Center Line 
j. Below Center Line 
k. Within Sigma Limit 
l. Alternating 
m. Alternating Lower Sigma Limit 

6. Enter a number of total values, a violation count, and 
sigma total (NSigma) associated with your rule. 

7. Press the Up and Down arrow buttons to adjust the 
relative priority of the rules in the rule set. Rules 
appearing closer to the top of the chart receive higher 
priority. 
 

Configuring SPC Tags 
To configure a tag for use in SPC charts and reports: 
 
1. Navigate to the Data Collections area in the Hyper 

Historian Project Explorer. 
2. Right-click the folder that should contain the SPC tag and 

select + SPC Tag. 
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3. Give the SPC tag a name, an optional display name, and 
a description. 

4. In the Properties section, select the logging group and 
data source that should be associated with this SPC tag. 

5. In the Properties section, select the SPC distribution rule 
set that this tag should follow. 

6. In the Properties section, select the summary statistics 
Collection Type for the tag. For this example, choose 
MedianR to see all possible settings. 

7. In the Properties section, set the Hi Limit and Lo Limit 
for the chart displaying data from this tag. 

8. In the Properties section, specify any triggers that, when 
activated, cause the tag to associate incoming data from 
the data source with a new group of values. 

9. In the Control Limits tab, specify whether the control 
limits associated with this tag should be constant values 
or based on the tag’s data.  

10. In the Statistics tab, specify the types of summary 
statistics that Hyper Historian should calculate for this 
SPC tag. 
 

5.17 Configuring a Trigger 
 

Starting Triggers 
 
If you already have a component running with Workbench, 
navigate to Triggers or Actions > Triggers. 

 
Creating a Trigger 
 
To create a new trigger, expand the Triggers selection (next 
to the lightning bolt icon) to show the trigger options.  
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Configuring a Data Trigger 
1. To add a new Data Trigger, right-click Data Trigger and 

then click + Data Trigger. 
2. Ensure the Enabled checkbox is checked. 
3. Enter the Name for the trigger.  
4. On the Basic tab, enter the optional Description. 
5. On the Basic tab, select the Trigger type. The following 

types are supported: 
• On any data change (event) 
• When data tag changes to TRUE 
• When data tag changes to FALSE 
• While data tag is TRUE 
• While data tag is FALSE 

6. On the Basic tab, select the data tag that is to be 
monitored and used as the basis for the trigger. You 
can browse for the tag or type in (or copy in) the tag 
name. 

7. On the Advanced tab, enter any of the optional 
advanced trigger conditions, as desired or needed.   
 
The (optional) advanced conditions include: 
• Time zone (either local server time or UTC) 
• Start time for monitoring the data tag 
• Stop time for monitoring the data tag 
• Trigger delay 
• Trigger repeat function 
• Trigger enable tag (the trigger is active only when 

this tag is TRUE) 
8. Click the Apply button to save the changes. 

 

Configuring a Time Trigger 
1. To add a new Time Trigger, right-click Time Trigger 

and then click + Time Trigger. 
2. Enter the Name for the trigger.  
3. Ensure the Enabled checkbox is checked. 
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4. On the Basic tab, you may enter an optional Description. 
5. On the Basic tab, select whether or not the time trigger is 

to be a condition or an event. If it is a condition, the Trigger 
tag will remain TRUE for the specified duration time. 

6. On the Basic tab, select the Recurrence type. The types 
include: 
• One time only 
• Time interval 
• Specific dates and times 

7. If the Recurrence type is One time only, select the date 
and time the trigger is to occur. 

8. If the Recurrence type is Time Interval, select the 
starting date and time, and the Recur interval. 

9. If the Recurrence type is Specific dates and times, select 
the Recur interval.  Note, depending on the units selected 
for the Recur interval, you will be prompted with different 
Recurrence details to enter. 

10. On the Advanced tab, enter any of the optional 
advanced trigger conditions, as desired or needed.  The 
(optional) advanced conditions include: 
• Time zone (either local server time or UTC) 
• Stop time for the Time Trigger execution 
• Trigger delay 
• Advance notification 
• Trigger enable tag (the trigger is active only when 

this tag is TRUE) 
11. Click the Apply button to save the changes. 
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5.18 Node Setup and Redundancy 
The Hyper Historian installation initializes the Node Setup 
and Redundancy configuration.  Its default settings are for a 
non-redundant single workstation setup (that is, a non-
redundant Hyper Historian logger with one local collector). 
Use the Node Setup and Redundancy configuration to 
perform any of the following changes: 
• Change the name or description of a collector or logger 
• Add or delete remote collector(s) (Enterprise Edition) 
• Specify the redundancy settings for a collector 

(Enterprise Edition) 
• Specify the redundancy settings for a logging server 

(Enterprise Edition). 
• Set up Store and Forward to cache and forward data if 

the connection to a collector is lost (Enterprise Edition). 

Configuring a Collector Node 
1. To add a collector, right-click the Node Setup and 

Redundancy icon and select + Collector. 
Note: If you want to edit an existing collector, double-
click the icon of the existing collector. 

2. Enter the name for the Collector 
3. Ensure the Enabled checkbox is checked. 
4. Enter an optional description, if desired. 
5. Specify information for the Store and Forward feature 

on the Store and Forward tab. This feature caches data 
if the connection to a collector is lost. When the 
connection to the collector is restored, the cache will be 
flushed, and the two (primary and secondary) databases 
will be automatically synchronized. Options are: 
• The maximum storage size on disk in megabytes 
• The maximum storage size in memory in 

megabytes 
• The maximum number of packages stored in 

memory 
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• If you want the most recently collected data to be 
stored and forwarded before all other data, put a 
checkmark next to Send Most Recent Data first.  

• Your discard policy (Discard oldest data first OR 
Discard newest data first) 

6. Next, select one of the following in the Properties tab:  
• Select In-Process Collector if you have installed 

one collector that resides on the same server as 
the logger. Go to step 14 for your remaining 
options, then proceed to the next section, 
“Configuring the Logging Server” on page 5.19. 

• Select Standalone Collector if you have the 
Enterprise edition of Hyper Historian and one or 
more separate standalone collectors have been 
installed, then follow the remaining steps, below the 
figure.  

7. From the Protocol drop-down list select the 
appropriate protocol. Which you choose depends on 
how the separate collector is configured to 
communicate with FrameWorX. Options include: 
a. HTTP Direct 
b. TCP Direct 
c. HTTP over FrameWorX  
d. TCP over FrameWorX 
e. HTTPS over FrameWorX  
f. WSHTTPS over FrameWorX  
g. Use Local FrameWorX as Mediator 

8. Enter a name for the Primary Node or select one from 
the drop-down list. The URL field below it will be pre-
filled from your primary node selection. (To modify the 
URL, see step 12.) 

9. Now you have the option to create a backup node by 
putting a check mark next to Enable Redundancy in 
Secondary Node. The steps 10-12 assume you have 
proceeded with configuring a backup node. 
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10. Enter a name for the secondary node or select one 
from the drop-down list. The URL field below it will be 
pre-filled from your backup node selection. (To modify 
the URL, see step 12.) 

11. Click the checkbox next to Auto Fail-back to switch 
from the secondary node to the primary node when the 
primary becomes active again. 

12. Click the checkbox next to Use advanced 
configuration to allow further configuration. Once the 
box is checked, you can click on the Advanced 
Configuration button at the bottom of the window to 
open the Advanced Redundancy Configuration window, 
where you can modify the Primary Node URL and/or 
Secondary Node URL directly. Note that changes to this 
configuration may require equivalent changes in the 
nodes configuration. Click OK to proceed. 

13. A heartbeat can be enabled for collectors to alert you to 
failed communication. To do so, click the checkbox 
Enable Heartbeat and select the data point that will 
record the result. 

14. Compression can be enabled for both data and the 
configuration by selecting the compression type from 
the dropdown lists in the Compression section. 

15. Click the Apply button to save the changes. 

Configuring the Logging Server 
1. To edit the Logging Server, double-click the icon of the 

existing Logging Server. 
2. Enter the name for the Logging Server 
3. Ensure the Enabled checkbox is checked 
4. Enter an optional description, if desired. 
5. Optionally, to make the server's historical data read-

only, put a checkmark in the Disable HDA Editing 
checkbox. If you do this, you won't be able to edit any 
Historical data being logged on the server using any 
programmatic interfaces. 
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6. Now you have the option to click the checkmark next to 
Redundancy to enable it. Steps 7-11 assume you have 
selected to enable Redundancy. 

7. Select your desired Protocol (HTTP or TCP) by using the 
drop-down list. 

8. Enter a name for the Primary Node or use the drop-
down list to select one. The URL field below will be pre-
filled depending on your selected primary node. (To 
modify the URL, see step 11.) 

9. Enter a name for the Secondary Node or use the drop-
down list to select one. The URL field below will be pre-
filled depending on your selected backup (secondary) 
node. (To modify the URL, see step 11.) 

10. Click the checkbox next to Auto Fail-back to switch 
from the secondary node to the primary node when the 
primary becomes active again. 

11. Click the checkbox next to Use advanced 
configuration to allow further configuration. Once the 
box is checked, you can click on the Advanced 
Configuration button at the bottom of the window to 
open the Advanced Redundancy Configuration window, 
where you can modify the Primary Node URL and/or 
Secondary Node URL directly. Note that changes to this 
configuration may require equivalent changes in the 
nodes configuration. Click OK to proceed. 

12. A heartbeat can be enabled for collectors to alert you to 
failed communication. To do so, click the checkbox 
Enable Heartbeat and select the data point that will 
record the result. 

13. Compression can be enabled for both data and the 
configuration by selecting the compression type from 
the dropdown lists in the Compression section. 

14. Click the Apply button to save the changes. 
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5.19 Configuring System Settings 
You will need to restart the Hyper Historian logger after 
making changes to the system settings. This can be done by 
clicking the traffic light icon in the top ribbon and waiting for 
it to turn red (indicating the logger has stopped) and then 
clicking it a second time to restart the logger. 

Configuring License Mode 
The Hyper Historian is available in two major editions, 
Standard Edition and Enterprise Edition. Both editions 
support the connectivity, data collection and logging, 
archiving, and data playback capabilities of the Hyper 
Historian.  
 
In addition to supporting these core capabilities, the 
Enterprise edition includes support for remote or standalone 
distributed data collection, redundancy (both at the collector 
level and the data logger/database level), store and forward 
capability, and optimization for multi-core and multi-
processor systems.   
 
The Enterprise Edition is optimized for performance in a 
distributed data collection environment where the data 
collection is performed on separate machines, not on the 
PC/workstation running the Logger.  The Standard Edition, 
on the other hand, is optimized for a single PC / workstation 
system where the entire Hyper Historian is running on one 
machine. 
 
The Hyper Historian Enterprise Edition users can run Hyper 
Historian Logger in Enterprise or Standard mode if the Hyper 
Historian is running on a single PC/workstation (that is, a 
non-redundant single workstation).  Running the system in 
Standard mode provides better logging performance and 
the possibility of achieving high throughput rates on a single 
PC solution. 
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In the System Settings, listed under System Administration 
in the Project Explorer, Enterprise edition users can set the 
License Mode.   
 
• Selecting the auto mode results in Hyper Historian 

using the mode version of Hyper Historian Logger and 
Collector that matches the configuration of the 
collectors (InProc if using local collectors, OPC UA 
version if using remote collectors). This is the default 
license mode for Enterprise edition users. 

• Selecting the standard mode results in the Hyper 
Historian using the InProc version of the Hyper 
Historian Logger and Collector, which is optimized for 
single PC/workstation performance. 

• Selecting the Enterprise mode results in the Hyper 
Historian using the OPC UA version of the Hyper 
Historian Logger and Collector, which is optimized for a 
distributed system, and one that supports redundancy, 
store-and-forward, and optimized performance on 
multi-CPU systems. 

 
It is also important to set the Disk Space Management 
settings. With these settings, you are able to set: 
 
• The amount of disk space remaining (in megabytes) 

before you receive a warning 
• The amount of disk space remaining (in megabytes) 

before you receive an error message and the Data 
Logger stops logging. 

 
 
 
 



Hyper Historian ICONICS Product Suite Getting Started  

 ICONICS 5-46 

Configuring Archive Settings 
Use the System Settings for the overall configuration of the 
Hyper Historian Archive function. The Hyper Historian 
Archive function automatically detaches older data from the 
system and moves the detached data to a specified location 
(that is, a specified folder).   
 
After archiving is enabled and the Hyper Historian has begun 
creating archived files, the archive files created by the Hyper 
Historian should be backed up to CD, DVD, tape, or some 
other permanent storage media for long term storage. 
 
To open the Archive settings screen, expand System 
Administration in the Project Explorer, select System 
Settings and verify the Options tab is selected. Note the 
additional tab called File Logger. Here you can set up archival 
parameters for your file logger. Each is described separately on 
the pages that follow. 
 
Archival for File Logger: 
 
To archive data from a file logger, click the File Logger tab. 
Use the Cache, Logger, Master Logger, Logger Data Store, 
and Master Logger Data Store sections to fine tune your 
archiving requirements. 
Using the Hyper Historian Archiving Management 
 
Once the Hyper Historian’s logged data is archived 
(detached from the system), the data is no longer available 
for playback on the trend display or available through the 
SQL Query interface.  
 
However, previously archived data can easily be reattached 
to the system and again made viewable on trend displays 
and accessible via the SQL Query interface. This is done via 
the Hyper Historian Archiving Management screen.  
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To access the Archiving Management screen, double-click 
the Archiving Management Icon located under the System 
Administration Icon in the Project Explorer. Your Archiving 
Configuration should be pre-filled from the information 
added within the System Settings.  

 
You will then be able to re-attach previously archived files by 
clicking the button and browsing to the folder containing the 
archive files to be reattached. You can multi-select files 
(using the Shift or Control keys). 
 
Note: The following naming convention is used for the 
Archive files: <Logger Name>_<Start Date>_<Start 
Time>_<End Date>_<End Time> where the format for the 
Date is yyyymmdd and the format for the Time is hhmmss. 

 
The re-attached archive files will be listed in the Attached 
Archive Files window. If you had selected Generate 
Metadata for Archiving Files in the System Settings, that 
metadata would appear in the window to the right.  





 

ICONICS 6-1 

6 MOBILEHMI 
6.1 Introduction 

In an increasingly web-connected environment operators 
from many industries have begun benefiting from mobile 
applications aimed at providing optimized operational 
experiences for everyday tasks. Expectations of software 
companies have centered on providing limitless access to 
information over wired, wireless and cellular connections. 
Due to this trend and the advance of mobile technologies, 
ICONICS has responded by completely renewing the 
MobileHMI product that is now available on the major 
providers of mobile devices – Microsoft, Apple, Amazon and 
Google – ICONICS MobileHMI is a full HMI/SCADA client on 
any device.  
Spanning desktops, tablets and phones, ICONICS products 
have always been centered on visualization of data. With 
MobileHMI, tablets and phones now include a fully featured 
mobile client designed for operations on the go. With 
configuration enhancements meant to simplify development 
of screens for mobile users, it is easier to provide a clean 
experience on all devices without incurring the extra cost of 
development time. Additionally, preconfigured templates 
and the ability to target specific devices with displays makes 
MobileHMI ready to handle any composition of devices.  
MobileHMI addresses the growing need for connectivity 
away from operator stations which allows personnel to 
access information from anywhere reducing the time it takes 
for issues to be recognized and fixed. The availability on all 
devices with consistent experiences also serves to unify 
efforts to mobilize operational teams without requiring 
upfront investment in device standardization. 
 

  



MobileHMI ICONICS Product Suite Getting Started  

 ICONICS 6-2 

Built on Industry Open Standards  
Using ICONICS’ Platform Services, MobileHMI is built on 
universal connectivity, allowing users to connect to system 
data from anywhere in the world. Native implementations of 
connectivity protocols allow MobileHMI to provide an 
unparalleled view of a wide variety of data types. 
Instant KPIs and Alerts 
Instantly receiving KPIs and alerts day or night on your 
mobile device allows you to be informed 24/7. This enables 
managers to monitor performance metrics in real time and 
operators to receive updates on-the-go. 
Quick Deployment to Any Device 
Deployment is instant after downloading the free app, 
allowing remote monitoring of your enterprise immediately. 
Devices can include Microsoft Surfaces, Windows 8 Phones 
and tablets, Apple iPads and iPhones, Amazon Kindle tablets, 
and Android phones and tablets. 
Dazzling Graphics, Alarms, Trends, Charts and Grids 
With mobile optimized alarms and assets (categorized by 
importance), quickly view your top priority alarms and act 
faster with better information. Accessing the high-
powered .NET graphical controls from any device reduces 
engineering time of mobile-ready displays and utilizes small 
screen sizes efficiently. 
Overlay Real-time Data on Detailed Maps 
Along with the real time data collected, implement mapping 
(integrated with Google, Bing, and ESRI map data) to show 
moving or geographically dispersed assets. Contextualize 
data into easy-to-comprehend information by positioning 
interactive assets virtually on a map. 
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Easily Design HMI Displays for Multiple Devices 
Using GraphWorX64, create single displays that scale 
dynamically for any device, form factor or resolution. Vector 
graphics scale seamlessly allowing content created for one 
device to be resized for another without losing quality. 
Standardized on ISA-95 Asset Navigation and 
Organization 
Creating and navigating assets is easy using the ISA-95 
organization. Allowing users to drill down for more data, the 
ISA-95 Asset Navigation can provide easy access to real 
world assets, as well as integrate commands to control their 
application. 
Smart Tiles with an Intuitive Interface 
ICONICS enables many natural user interface-based 
productivity features delivered by the latest smart devices. 
Smart Tiles are similar to Microsoft’s Live Tiles, but can be 
used within HMI displays on multiple devices. 
Remote Monitoring of Critical Infrastructure 
Remote monitoring with this application is ideal for 
industries such as Water & Wastewater, Wind, Solar and 
Renewable Energy, Process Manufacturing, Pharmaceuticals, 
Biotech, Oil & Gas and Electric Utilities. Remote Monitoring is 
also useful for management scorecards and Data Centers. 
Ideal for Operators, Executives and Maintenance 
This mobile solution allows operators to stay informed, even 
while traveling, by viewing assets with navigation. Executives 
can visualize business performance and improve enterprise-
wide communications. With real-time updates and 
information delivered through remote monitoring, 
maintenance is easier than ever to plan and schedule. 
 
 
 



MobileHMI ICONICS Product Suite Getting Started  

 ICONICS 6-4 

KPIWorX Self-Service Dashboards 
KPIWorX allows for the creation, saving and loading of 
dashboards, providing a user-friendly interface. Users can 
drag and drop data, configure widgets, split screens to add 
new widgets and save dashboards into a Favorites location. 
KPIWorX is accessible through MobileHMI as well as within 
GraphWorX64 (which can handle more complex displays).  
KPIWorX contains several preconfigured widgets, such as 
gauges, process points, trends, alarms and grids. Primarily a 
mobile feature, all new functionality is also available on the 
desktop.  
Augmented Reality – Location Services 
Location Services are a group of Augmented Reality 
MobileHMI features that allow displays to automatically load 
and display data based on the users’ location and proximity 
to devices and meters. These services include QR codes, 
barcodes, NFC, OCR and GPS.  



 

ICONICS 7-1 

7 ANALYTIX 
7.1 Introduction 

Welcome to ICONICS AnalytiX®, a new generation of 
Manufacturing Intelligence software designed to help you 
increase profitability, reduce energy and maintenance costs, 
control operating costs, and react to emergent situations 
before they negatively impact your bottom line. 
 
AnalytiX empowers decision makers at all levels of the 
enterprise with real-time information to help them drive 
global operational efficiency and strengthen competitive 
market advantage. ICONICS AnalytiX solutions leverage the 
latest Microsoft technologies including the Windows Server 
platform, SQL Server, and SharePoint for rich, IT-friendly 
visualization components. 
 
ICONICS AnalytiX is comprised of the following products: 
 

• AnalytiX Suite* 
• Facility AnalytiX® 
• CFSWorX™ 
• BI Server 
• BridgeWorX64™ 
• ReportWorX64™ 

 
* The AnalytiX Suite installation is comprised of the following 
options: 

o Platform Services – Core connectivity and 
communications layer shared between products 
o Facility AnalytiX – Predictive Software for 

Facilities Management 
o Help – Product Documentation 
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ICONICS AnalytiX Installation also includes the Workbench 
multi-functional, centralized web-based environment. 
This Getting Started manual explains how you can: 

• Install the AnalytiX software. 
• Familiarize yourself with and start using the 

Workbench 
• Access online help and technical support. 

Note: This manual is an abbreviated version of the full 
AnalytiX Help documentation, which is available in the 
AnalytiX product installation. 
 

7.2 Quick Start 
This chapter provides a brief overview of the following 
AnalytiX products and tools: 

• Workbench 
• Facility AnalytiX 
• CFSWorX 
• BI Server 
• BridgeWorX64 
• ReportWorX64 
• Quality AnalytiX 
• Additional tools and utilities 

Note: For complete information about any AnalytiX product, 
please refer to the Help documentation, which you can 
launch from the ICONICS product itself. 
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7.3 Workbench 
The ICONICS Workbench is a multi-functional, centralized 
web-based environment is included as part of the Platform 
Services in the AnalytiX suite installation. 
 
The Workbench offers a light-weight deployment with a fast 
startup time, which also supports third-party plug-ins. The 
updated Workbench, including familiar elements such as a 
tool bar ribbon and Project Explorer, but with enhanced user 
friendly options such as a list-view Project Explorer for 
browsing which can be filtered and sorted. 
 
The Workbench runs in all browser platforms, including 
Microsoft Internet Explorer, Firefox, Chrome, Safari, and 
more.  
 
In the Workbench, you can: 

• Organize data sources on the basis of a 
hierarchical structure of assets and equipment, 
using AssetWorX. 

• Locate and react to Facility AnalytiX faults if the 
FDDWorX provider is installed. 

 
Many configurations can be done from within the 
Workbench.  
 
To open the Workbench from the Windows Start button, 
select All Programs > ICONICS > Workbench. 
 
When you open the Workbench for the first time, you will be 
able to see all of the applications, tools, utilities and services 
listed in the Project Explorer that you can open within the 
Workbench. 
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It is made up of: 
• The Ribbon bar (along the top). 
• Two Project Explorers that you can hide or show: 

o A tree explorer that gives you a way to 
navigate and browse; and buttons that give 
you access to ICONICS providers. 

o A grid explorer you can use for searching. 
• The content or work area where configuration 

forms open. 
 
Ribbon: 
The ribbon for the Workbench is designed to help you 
quickly find the commands you need to complete a task. 
Commands are organized into logical groups. 
 
The Home tab provides general tool bar functions and 
changes depending on the item that is selected in the 
Project Manager. In addition, ProjectWorX allows you to 
utilize new features for your database. Examples are shown 
below. 

  
You can minimize the ribbon by double-clicking on the 
ribbon tabs. 

  
Development and runtime modes of all installed and 
licensed ICONICS (AnalytiX and GENESIS64) products can be 
accessed and used in the Workbench.  

 
Even though all of the providers are available in the 
Workbench, you can pick and choose which providers appear 
in the Workbench's Project Explorer. 
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7.4 Facility AnalytiX/FDDWorX 
Facility AnalytiX is a predictive building automation solution 
powered by ICONICS’ powerful FDDWorX engine with 
advanced Fault Detection and Diagnostics (FDD) technology 
at its core to detect and predict faults in equipment. It 
incorporates algorithms that weigh the probability of faults 
and advises management, operators and maintenance 
personnel of actions to prevent equipment failures or 
excessive use of energy. With Web-based configuration, 
Facility AnalytiX is easy to setup and deploy, integrating with 
most popular BAS, SCADA and building systems. An 
extensive library of standard equipment diagnostic models 
speed setup and configuration, while a rules based editor 
lets you easily customize and add new equipment 
diagnostics models. 
 
When equipment failures occur, advanced software 
technology provides automatic guidance to a list of causes 
sorted by probability, resulting in reduced downtime and 
lower costs to diagnose and repair.  
 
Information obtained from Facility AnalytiX can be used to: 
 

• Predict, reduce, and eliminate equipment 
downtime 

• Automate fault detection and real-time 
notifications 

• Reduce maintenance and determine probable 
causes 

• Improve reliability and control 
• Improve overall environmental quality 

 
To launch Facility AnalytiX, from the Windows Start menu, 
select All Programs > ICONICS > Workbench. Then, select 
the Facility AnalytiX provider within the Project Explorer on 
the left. 
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7.5 CFSWorX 
ICONICS CFSWorX is a Connected Field Services solution 
containing a set of digital tools that provide: 

• Realtime Monitoring of Field Equipment 
• Realtime Monitoring of Service Worker Availability 

and Location 
• Alerts to Field Workers when Field Equipment 

Requires Service  
o Equipment status alerts (alarms) 

available to all Field Workers 
o Can auto-notify Field Worker(s) of Field 

Equipment Failures 
o Can Choose the Most Appropriate or 

Closest Service Worker 
o Monitors Responses from Notified 

Service Workers 
o May Notify Backup Worker(s) in case 

Primary is Not Available 
• A Maintained Audit Trail of Notifications and 

Activity 
 
CFSWorX is comprised of multiple entities including:  

• Monitoring (of both Field Equipment and Field 
Workers) 

• Workflows 
• Alerting (via Notifications) 
• Mobile App  
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7.5.1 Monitoring - Field Equipment 
The monitoring of Field Equipment involves a backend of 
data source connectivity options (CFSWorX can work with 
any Platform Services real-time data source [e.g., 
OPC UA, Modbus, SNMP, etc.) and a robust Monitoring 
Engine (using AlarmWorX64 Server, Platform Services and 
AnyGlass Engine technology). The front end involves Alarms 
(exposed as A&E Events), and the mobile client (providing an 
alarm viewer for alarm details, alarm acknowledgment, and 
availability response options). 
 

7.5.2 Monitoring - Field Worker Availability 
CFSWorX is able to maintain a database of an organization's 
field workers. Users also have the option of syncing the 
database with third-party identity databases such as Active 
Directory or CRM. Users can also decide whether to sync 
external data or use local definitions - using information 
such as contact info (name, email, cell number for SMS, etc.) 
or CRM calendar. In addition, CFSWorX can associate 
ICONICS solution-provided data such as schedules (if not 
external), alarms, assets, mobile device health data (updated 
periodically), security ID, and groups. 
 
CFSWorX also includes Field Worker Mobile Health 
Monitoring. This includes Signal Strength, Battery Life, and 
Location (GPS). 
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7.5.3 Workflows 
CFSWorX utilizes a new customizable Workflow Engine, 
based on existing ICONICS Workflow components. CFSWorX' 
Workflow engine provides the ability to both receive and 
consume alarms. It also supports additional states (including 
Rejected, Busy, and Accepted) via association between 
alarms and users. Generated alarms can be logged by 
ICONICS' alarm logger component, can be viewable by alarm 
viewer, and can be optionally send via SMS or Email Alerts. 
CFSWorX' Worfklow will introduce new transaction execution 
options, including Alarm Source. It will also introduce new 
Blocks, similar to those used within ICONICS Bridging and 
standalone Workflow components. These include: 

• Alarm Event Output 
• Conditions Common: 

o Ack 
o Alarm 
o Normal 

• Conditions CFS: 
o Fixed Contact List 
o Worker Lookup 
o Accept 
o Busy 
o Reject 
o Assign 

• Communication Channel Send 
o SMS 
o ATT 
o Twilio SMS 
o Twilio WhatsApp 
o Others (future) 
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Note that the following Workflow Blocks are not available for 
use with CFSWorX: 

• CSV File Reader 
• XML File Reader 
• CSV File Output 
• XML File Output 
• Data Set Reader 
• Historical Input 
• Historical Alarms Input 
• Bulk Real Time Input 
• Bulk Real Time Output 
• Bulk Data Manipulator 
• Data Manipulator 
• Data Set Transformer 

 

7.5.4 Notifications 
CFSWorX' Alert Engine architecture users a REST API to work 
with third-party services. It supports SMS 
acknowledgements, as well as alarms. It also log activity to 
an audit log. The pluggable architecture supports continued 
enhancements. 
Users are able to configure both reliable and "best effort" 
Device Notifications. The reliable notifications utilize 
ICONICS' FrameWorX to FrameWorX Mobile technology 
to transmit alarms. This channel supports Error Notification 
as well as Retry. The "best effort" notifications involve SMTP 
(email) and SMS (text messaging) technologies.  
That being understood, data sent in this manner cannot be 
guaranteed. These efforts are used only to notify users to 
launch a native application. Communications may go 
through a service provider such as ATT, Twilio, etc. 
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7.5.5 CFSWorX Mobile App 
The CFSWorX MobileApp is based on ICONICS' MobileHMI 
technology and is able to be run on iOS and Android 
devices. It has the ability to collect and report mobile device 
health. It displays alarms in a MobileHMI Alarm Flip View. 
The mobile app supports new CFS worker response options, 
including Accept, Busy, and Reject. The displays (including 
operator/dispatcher dashboards) are customizable. 

7.6 BI Server 
The landscape of data in today’s applications is of very 
diverse nature: systems are made of a large variety of 
components, many of which have their own data storage and 
their own interface to provide access to stored data – 
whether it is a web service ,a database, an historian, etc. 
 
This scattering of information often makes it difficult to 
provide a cohesive view of a system and, even in cases where 
all the data can be visualized together, it might not be 
shaped logically for the end user. Correlating these different 
datasets with each other is challenging and trying to query 
them using a common set of filters or parameters is difficult. 
 
AnalytiX-BI was created to address these problems. Data is 
organized in user-defined Data Models, representing 
collections of datasets that are logically related to each 
other, irrespective of their physical origin. Data Models are 
connection to actual data using Data Flows; ETL processes 
that allow multi-step transformations of the ingested data 
for better shaping and filtering before loading it in a model. 
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7.6.1 AnalytiX-BI Overview 
There are many ways to use AnalytiX-BI, but the diagram 
below outlines the most common and most powerful 
architecture, and the way the pieces are designed to work 
together. 
 
Following the data from the bottom up, your originating 
data sources can be just about any piece of data that 
ICONICS can connect to, whether it be OPC, web services, 
Hyper Historian, AssetWorX, or a custom database. This data 
is pulled into data flows. Each data flow is a sequence of 
steps to modify and shape the data to best fit the data 
model. Data flows can be parameterized, so clients can get 
only the specific data they need. 
 
Note: Data flows are not cached. Each time a data flow is 
accessed, the data is read from the data sources anew and all 
steps are followed. 
 
Once the data has been shaped by data flows, it is pulled 
into data tables inside a data model. The data model defines 
relationships between the tables. These relationships make it 
easy to query the data. Data models cache the data, and use 
a number of techniques to optimize memory use and 
performance. (See Performance Considerations.) 
 
Data from a data model can either be queried directly by 
clients such as GraphWorX64 or KPIWorX, or the user can 
predefine views for a data model. Views can be based on the 
data tables, or on other views. Due to the predefined 
relationships, it is very easy to query the data model without 
having to worry about the proper JOINs between tables. 
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Since the data model is cached, triggers can be defined on 
each data table in the model to re-query its data source. 
Triggers can tell the table to be dropped and recreated 
anew, or only update the records that have changed. Each 
table can have multiple triggers, so you can define the best 
scheme to ensure your table is refreshed in the manner best 
suited for it. Triggers can work with parameters of data flows 
to only pull in data since the last data model refresh. 
 
This architecture takes full advantage of all the features of 
AnalytiX-BI, but it is flexible, and many of its parts are 
optional. If there is no need to shape or parameterize your 
data, you can pull a data source directly into a table inside a 
data model without using a data flow. You can connect your 
clients directly to data flows without a data model if you only 
need to do some shaping and have no need to cache the 
data. You can forego views, and simply connect your clients 
directly to the model, writing your query within a point 
name. 

7.7 BridgeWorX64 
The Bridging provider in the Workbench, based on ICONICS' 
BridgeWorX technology, provides Graphical Data Bridging, 
taking advantage of multi-core, 64-bit systems as well as 
utilizing .NET 4.6 and the Parallel Tasks Library.  
 
It also fully integrates with ICONICS V10 Platform Services, 
including: 

• Common Workflow Execution Engine 
• Data Flow Library 
• GridWorX 
• Web Services 
• BI Server 
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• OData (REST) 
• Facility AnalytiX, AlertWorX, ReportWorX, etc. 

 
The Bridging provider in the Workbench provides multiple 
user benefits, including: 

• Transaction Workflow Execution 
• Transaction Triggering 
• Enterprise Service Design 
• Transaction Recovery Option 

 

7.7.1 Transaction Workflow Execution 
Transaction Workflow Execution includes: 

• Diagram Designer - providing custom control flow 
logic 

• Drag & Drop configuration of Transaction Diagram 
Activities 

• Connectivity to heterogenous data sources 
• On Complete, On Success, On Fail, On True, On 

False control flow branching 
• Ability to execute custom .NET code in a 

Transaction 
 

7.7.2 Transaction Triggering 
Transaction Triggering provide the following trigger types: 

• Manual 
• Periodic 
• On OPC Data Value Change 
• On Alarm 
• On Database Value Change 
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• On File/Directory Change 
• On NT Event posted 

 

7.7.3 Enterprise Service Design 
Enterprise Service Design provides: 

• Multithread/multicore design with Parallel Task 
Library 

• Concurrent Transaction execution on a Thread 
Pool 

• Workflow Priorities: Normal, Below Normal, Above 
Normal 

• If the Workflow Engine is already running at 
maximum capacity, then other submitted 
workflows are enqueued in the Priority Queue. 

• Powerful transaction options for enqueuing 
transactions: 

o Queue and Execute immediately 
o Queue and Execute if no other similar 

transaction is running 
o Queue and Execute if no other similar 

transaction is running or enqueued 
 

7.7.4 Transaction Recovery Option 
The Transaction Recovery Option provides: 

• Heartbeat of running Transaction 
• Recovery Options 

o No Recovery 
o Re-Execute from Start 
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7.7.5 Transaction Data Sources 
All transaction data sources will come from the BridgeWorX 
DataFlow engine. Real 'live' data sources (i.e., those driven by 
subscription-based callbacks) are converted into datasets at 
the moment of consumption. 
 
Single values (e.g., OPC DA, BACnet, SNMP, etc.) are 
represented as a simple data set containing at least a value, 
quality and timestamp. However, they may include any 
additional properties requested by the user (e.g., engineering 
units, high/low range, etc.). 
 
Current alarms (e.g. OPC A&E, BACnet, custom point 
managers, etc.) are transformed into a dataset (table) when 
activity executes (like a snapshot of a "current" active 
alarms pattern). 
 
Data sources that are not subscription-based, but require 
polling, will make use of reader blocks to control exactly 
when the Read is executed, including: 

• Datasets (e.g., Web Services, Database Queries, 
custom point managers) 

• Historical Data (e.g., OPC HDA, BACnet, custom 
point managers, etc.) are transformed into a 
dataset (table) 

• CSV files 
• XML files 
• JSON files 
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7.7.6 Transaction Activities 
Transaction Blocks (activities) are used to manipulate the 
data. Internally, they handle data as in-memory datasets. 
 
All Reader Activities will have at least one output dataset. 
 
The Expression Syntax allows users to use any Activities 
output value of row X, column Y in expression calculations. 
 

7.7.7 Variables 
Global and Local Variables in Bridging in the Workbench are 
typed DataSets. Schema defines column names and column 
data types. Global Variables are exposed by BridgeWorX64 
Point Manager as DataSets. 
 
Elements of Global, Local, Trigger Variables or Parameters 
could be used as data sources or in expression calculations. 
 

7.7.8 Configuration 
Bridging configuration is easy to use and maximizes available 
space within the Workbench tool. It is possible to use Drag & 
Drop within transactions. Each activity has an 
intuitive configuration tool, with no popups. A handy library 
of activities is available, as well as visual feedback about any 
errors within diagrams. 
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7.8 ReportWorX64 
A new data reporting ability has been added to GENESIS64 
via a new provider within the Workbench. Reports are 
integrated in the system, similar to how alarms or historical 
data are treated. 
 
Reports in the Workbench in GENESIS64 contains multiple 
features, including: 
 

7.8.1 Report Dashboard 
Data Integration 

• Uses simple drag-and-drop interfaces to create 
flexible, interactive data visualizations 

• Integrates with the AnalytiX BI Server 
• Contains drill-down capabilities 
• Can share data to any device 
• Uses Responsive Design - for access on any device 

any time in any location 

7.8.2 Report Server 
• Supports features of ICONICS ReportWorX32 32-

bit-based reporting product 
• Integrates with ICONICS FrameWorX Server 

o Data can be consumed by any client 
o Utilizes unified security and licensing 
o Does not require Microsoft Excel to be 

installed on the server 
o Uses standard OpenXML SDK to 

manipulate reports 
o Each report exposes a list of tags that 

can be browsed 
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7.8.3 Report Sources 
• Data sources are unified for a complete view of 

information 
• Utilizes a Data Flow Library 

 

7.8.4 Report Generation 
Reports can be scheduled at specific times or under specific 
conditions. Actions (Workflows, Schedules, Triggers) can be 
used to execute reports. 
 
Reports can also be manually generated. A Report Control 
Page can be utilized on any glass, similar to ICONICS Health 
Monitoring System. 
 

7.8.5 Report Execution 
Report Execution is performed when the server retrieves the 
template from the configuration. The OpenXML SDK is used 
to generate the reports. (Note that Microsoft Excel is not 
required on the server side.) The generated report is saved in 
a runtime database, which is not tied to the configuration 
database. 
 
Users can use the system to deliver customized reports 
anywhere automatically. In addition, generic commands can 
be executed when reports are successful, are failing or simply 
when completed. 
 
ICONICS' commanding abilities have been enhanced to 
support the ability to attach reports. For example, a "Send 
Email" command could forward a report to AlertWorX. 
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7.9 Quality AnalytIX 
Quality AnalytiX is part of the AnalytiX product suite for 
GENESIS64. With Quality AnalytiX, you can monitor the 
efficiency and reliability of any system using statistical 
methods. These tools allow you to detect and correct for 
anomalies in your industrial process more easily than ever 
before. 
 
This component of the AnalytiX suite allows you to access 
and configure SPC tags, distribution rules, and statistical 
calculations in Hyper Historian. You can also create and view 
trends and alarms associated with SPC tags and calculated 
tags within TrendWorX64 or AlarmWorX64.  
 
Quality AnalytiX also supports: 

• New chart types in TrendWorX64 (Histogram and SPC)  
• Integration with ReportWorX Express  
• Dashboard customization in PortalWorX 

 
Quality AnalytiX delivers charts, KPIs, data, and alerts to any 
device, any time. It also provides an extensive set of viewing 
options to create dazzling displays and dashboards for your 
device. These views allow you to monitor your processes, 
identify issues, and fix them in a proactive manner to achieve 
better performance for your system. 
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7.10 Additional Tools and Utilities 
There are additional tools and utilities that are installed with 
AnalytiX. A brief description of each is described in the 
remainder of this chapter. For more information about a tool 
or feature, refer to the Help documentation included with the 
product. 

7.10.1 License Utility  
License Utility (Start > All Programs > ICONICS Licensing > 
ICONICS .NET Licensing > License Utility) provides full 
authorization for use of any purchased AnalytiX product and 
its available options.  
MonitorWorX Viewer (Start > All Programs > ICONICS 
Licensing > ICONICS .NET Licensing > MonitorWorX Viewer) 
allows users to review the status of ICONICS licenses.  

7.10.2 Configure AnalytiX  
Configure AnalytiX (Start > All Programs > ICONICS > 
AnalytiX > Configure AnalytiX) allows you to configure the 
product similar to the options you were provided during 
installation. See Step 8 onward of “Starting the Install / To 
Install AnalytiX” in this guide for detailed steps. 

7.10.3 SQL Server Setup  
SQL Server Setup (Start > All Programs > ICONICS > Tools 
> SQL Server Setup) allows you to select the SQL Server(s) 
that will be used by the ICONICS applications. The added 
SQL Servers will then appear in the Workbench to assist in 
the creation of, or connection to, databases. 

7.10.4 TraceWorX  
TraceWorX (Start > All Programs > ICONICS > Tools > 
TraceWorX) provides online diagnostics and tuning of 
ICONICS applications. TraceWorX is intended for use by 
systems integrators, OEMs and customers who want to have 
tools for doing their own troubleshooting and diagnostics. 
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8 ALARMWORX64 MULTIMEDIA  
8.1 What Is AlarmWorX64 Multimedia? 

AlarmWorX64 Multimedia is the next generation of modular 
automation for advanced OPC-based HMI and Visualization 
by ICONICS. It is an option of AlarmWorX64 64 that provides 
OPC-compliant multimedia technology for remote alarm 
notification, enabling you to send and receive alarms using 
various multimedia agents. 
Use the AlarmWorX64 Multimedia provider in the 
Workbench to configure alarms on several different types of 
media agents that can notify anyone, anywhere, of an 
occurring alarm. You can also use it to: 
• Configure alarms, alarm action sets, multimedia agents, 

and alarm acknowledgement codes.  
• Create subscriptions to OPC Alarm and Event (AE) 

servers.  
• Configure schedules and destinations for alarm 

notification messages. 
Multimedia agents you can use include: 
• Telephony agents, which include: call-out agents, call-

in agents, and public address (PA) agents for delivering 
and receiving alarm notifications. 

• Pager agents that page you when an alarm occurs. 
• Video agents that play prerecorded video or video 

captured at the moment of an alarm. 
• Email agents that use standard email for alarms, 

acknowledgements, files, and more. 
• Social Media integration to services such as Yammer 

for improved collaboration. 
• Skype messaging agents that deliver instant text 

messages to any Skype account. 
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• Marquee agents that send alarms and event messages 
to a computer’s scrolling marquee (software marquee 
agents) and external scrolling marquees (IP device 
marquee agents). 

• Sound/text-to-speech agents that play prerecorded 
sounds and speech over the network. 

• Fax agents that use a fax machine to send alarm 
notifications. 

• Popup agents that launch applications, provide alarm 
messages, and execute files on a compute. 

• Task tray agents that deliver pop-up messages to the 
Windows task bar. 

• Custom agents that let you create your own 
multimedia agent. 

 

8.2 Configuration - Workbench and AlarmWorX64 
Multimedia  

To configure AlarmWorX64 Multimedia , you use the 
Workbench, an integral part of ICONICS’ GENESIS64 64-bit, 
OPC-integrated, Web-enabled HMI/SCADA suite. Workbench 
is loaded as part of the AlarmWorX64 Multimedia installation 
and is a multi-functional, centralized, Web-based 
environment for product configuration.  
The Workbench can also act as an advanced operator 
interface for visualization and service management and has 
integrated layout/project management and remote, pack-
and-go deployment capabilities. 
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8.3 Starting the Workbench 
To launch the Workbench directly from your desktop, click  
Start > All Programs > ICONICS Product Suite > 
Workbench. 
 
If you already have a component running in Workbench, 
select AlarmWorX64 Multimedia in the Project Explorer 
navigation menu. 

 

8.4 Creating Alarm Configurations 
To create alarm configurations in AlarmWorX64 Multimedia , 
follow these steps: 
1. Connect to an AlarmWorX64 Multimedia database. 
2. Create subscriptions. A subscription defines a 

connection to an alarm server, and specifically describes 
alarms that the Multimedia component is interested in. 

 
3. Create alarm filters. Alarm filters allow you to filter an 

alarm subset. You can make filters that only filter a 
specific alarm tag or filters that filter a group of alarms. 
The Multimedia Server uses alarm filters to specify 
which subset of alarms will be used to initiate a 
multimedia action. 

4. Create multimedia agents. An agent is the means for 
notifying operators when an alarm reports. The means 
can be any of the supported multimedia in 
AlarmWorX64 Multimedia . Once you have defined an 
agent, you can use it (along with any other agents) in 
any action sets. As a result, when an alarm reports, its 
subscription's action set knows which media to use to 
notify operators. 
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5. When creating most agents, you can also specify the 
person to be notified. You can even set up schedules so 
that notifications are sent to the person on duty at the 
time the alarm occurs. To do this, you set up roles and 
schedules. This is an optional step for getting started, 
but is a handy feature for setting up alarm notifications 
and acknowledgements. 

6. You also have the option to create media templates 
for any agent. Templates are helpful if you are creating 
many agents for one type of multimedia device. 

7. Create alarm configurations. Each new database you 
create will have a default alarm configuration; this is the 
alarm configuration you should plan to use if you are 
just creating one alarm configuration for your computer 
to follow.  
 
If you create a new alarm configuration with a name 
other than "Default," you will also need to create a new 
node configuration and link it to your alarm 
configuration.  

8. Create action sets. An alarm action set is a set of 
actions that the Multimedia Server will enact whenever 
an alarm from that subscription occurs. 

9. Make the database active.  
10. Start the Multimedia Server.  
Each step is described in the online Help that is available in 
AlarmWorX64 Multimedia.  
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8.5 Starting the AlarmWorX64 Multimedia Server 
 
In order for the AlarmWorX64 Multimedia Server to use the 
information in the configuration database, the server must be in 
"runtime" mode. To start the server: 

 
1. Click the stoplight button on the Home ribbon in the 

Workbench. 
2. Verify that the server is connected to the configuration 

database by checking that the Multimedia Server 
journal log is receiving alarms. You can access the log 
from within AlarmWorX64 Multimedia tree in the 
Workbench ([Database name]\System Tools\Server 
Journal Log). 





 

ICONICS 9-1 

9 GENDEMO 
9.1 Introduction  

You can get a sense of the rich applications that can be 
created by using ICONICS' GenDemo. GenDemo is a set of 
GraphWorX64 display files installed with your system to help 
you explore and learn about the features of GENESIS64, 
AnalytiX, MobileHMI, and Hyper Historian, as well as to find 
out how ICONICS applications are adaptable to different 
industries.  
This chapter provides a brief overview of GenDemo. You are 
strongly encouraged to explore all the available files. 

 
 
To launch GenDemo, from the Windows Start menu, select 
Programs > ICONICS Tools > GenDemo. This opens the 
GenDemo home page, shown above. This can also be 
reached by navigating to http://gendemo.iconics.com. 

 
 
 
 
 

http://gendemo.iconics.com/
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9.2 GenDemo Options 
There are several configurable options that are located along 
the bottom of the GenDemo screen, which may be useful 
when navigating.  They are: 
Run in Carousel Mode - This button opens the Carousel 
display and enables the Carousel mode, which automatically 
advances through a set of displays according to the selected 
playlist. The Carousel display also allows you to open the 
Carousel control panel for more granular control over 
playlists. 
Select Color Scheme - This button allows you to select from 
a variety of different color themes for your GenDemo 
application. 
Select Language - This button allows you to change the 
language of your GenDemo application. Don’t see your 
desired language? Contact us to put in a request at 
info@iconics.com. 

9.3 Industry Case Studies and Examples 
As stated earlier, GenDemo contains a large number of 
example projects, many of which have been used by real 
customers. You may find specific examples related to a 
particular topic in the respective topic’s menu, or you may 
open the complete list of demos separately. The list of 
demos can be found from the menu under the Industries > 
Customer Examples section. This will open up a display 
containing all of the GENESIS64 examples that come with 
GenDemo. You are encouraged to look through these and 
see how the graphics have been developed. If you would like 
to learn more about how any of the examples function, you 
are encouraged to open the files themselves, in 
configuration mode, from the GenDemo > Examples 
directory where you installed GENESIS64.

mailto:info@iconics.com
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10 HELP AND TECHNICAL SUPPORT 
10.1 Help Documentation 

ICONICS software provides online help with descriptions and 
explanations of each application. Help is available 
throughout ICONICS Suite. You can access help in the 
following ways: 

• Click the Help  icon in the Workbench. This opens the 
help file for that application. To search for a topic in the 
help file, click the Index tab or the Search tab. Type or 
select the term you want to find, and then click the 
topic you want to read. 

• Press the F1 key to display context-sensitive help. 
• Click the Help button in any dialog box to display 

context-sensitive help for that dialog box. 
• Move the mouse pointer over an icon and pause for a 

moment to display pop-up ToolTips for quick help. 
• From the Windows Start menu, select All Programs > 

ICONICS Help > Help 
 

10.2 Technical Support 
10.2.1 Telephone Support 

ICONICS support centers are open Monday through Friday, 
year round, except for local holidays and ICONICS holidays.  
Support handles calls on a first-come, first-served basis 
during the business hours below. 

Americas (United States):  
1-508-543-8600 

8:00 AM – 6:00 PM 
Eastern Standard Time 

Europe (Czech Republic):   
+ 420-377-183-420 

9:00 AM – 5:00 PM  
European Central Time 
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Asia Pacific (Australia):  
+ 61-2-9605 1333 

9:00 AM – 5:00 PM  
Australian Eastern Time 

Please have the following available when you call: 
• Your SupportWorX Plan Number. 
• A PC available for tests and diagnostics. 
• A clear understanding about the issue. 
• The version of your OS and the ICONICS product(s). 
• OPC server or relevant third-party software info. 
Note: Go to 
https://getconnected.iconics.com/ICONICS/Support/GetSupp
ort.aspx to contact our Technical Support department.  

 
Email Support 
The ICONICS support center email addresses are: 
• North America: Support@ICONICS.com 
• Europe: EuropeSupport@ICONICS.com 
• Pacific Rim: PacificRimSupport@ICONICS.com 
Please include your SupportWorX Plan Number when 
sending your message. Email requests will be answered on a 
first-come, first-served basis typically the same day. 

 
 

https://getconnected.iconics.com/ICONICS/Support/GetSupport.aspx
https://getconnected.iconics.com/ICONICS/Support/GetSupport.aspx
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